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Sobre este tutorial 
Neste tutorial, você irá configurar um novo projeto, selecionar diversas configurações de 
projeto e salvar o projeto como um modelo que pode ser usado para outros novos 
projetos. 


Observação: Se você precisar de ajuda adicional em qualquer momento em que estiver 
usando o software, pressione F1 para exibir para a ajuda online. 


Etapa 1. Criar um novo projeto 
1. Na barra de menu do Trimble Business Center, selecione Arquivo > Novo 


projeto. 


A caixa de diálogo Novo projeto é exibida. 


 


2. Certifique-se de que <Modelo em branco> está selecionado na lista e clique em OK. 
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A Visualização do Plano é exibida na janela do Trimble Business Center. Você 
agora está pronto para selecionar as definições de configuração para seu projeto. 


 


Observação: Esta figura mostra a Visualização de plano com um plano de fundo 
branco. Seu plano de fundo pode ser preto. Se desejar alterá-lo para branco, 
selecione Ferramentas > Opções e selecione Cor do plano de fundo: Branco na 
caixa de diálogo Opções. 
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Etapa 2. Selecionar configurações de projeto 
Você pode selecionar uma grande variedade de configurações para seu novo projeto. 
Para esse tutorial, você especificará diversas configurações de projeto de Sistema de 
coordenadas, Unidade, Processamento da linha de base e Visualização. Para todas 
as outras configurações de projeto, você manterá os padrões. 


Para abrir a caixa de diálogo Configurações do projeto, selecione Projeto > 
Configurações do projeto. Ou clique no ícone Configurações de projeto  na barra 
de ferramentas. 


 


 


2a. Selecionar configurações do Sistema de Coordenadas 
Nesta etapa, você selecionará o sistema de coordenadas que deseja usar para o projeto. 


1. No painel de navegação (esquerdo) na caixa de diálogo Configurações de projeto, 
selecione Sistema de coordenadas. 


2. Clique no botão Alterar. 
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Se você tiver selecionado anteriormente um sistema de coordenadas, a caixa de 
diálogo Selecionar sistema de coordenadas é exibida mostrando uma lista dos 
sistemas usados anteriormente. Se essa caixa de diálogo for exibida, clique na 
opção Novo sistema e no botão Próximo. 


 


Se nenhum sistema tiver sido selecionado anteriormente, ou você tiver clicado na 
opção Novo sistema na caixa de diálogo Selecionar sistema de coordenadas , a 
caixa de diálogo Selecionar tipo de sistema de coordenadas. 


3. Na caixa de diálogo Selecionar tipo de sistema de coordenadas , selecione a 
opção Sistema de coordenadas e Zona. Então clique no botão Próximo. 


A caixa de diálogo Selecionar zona do sistema de coordenadas é exibida. 
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4. Faça o seguinte: 


a. Na lista Grupo do sistema de coordenadas, selecione Plano Estadual dos 
EUA 1983. 


b. Na lista Zona, selecione Colorado Norte 0501. 


c. Clique em Próximo.  


A caixa de diálogo Selecionar modelo de geoide é exibida. 


 


5. Faça o seguinte: 


a. Selecione a opção de modelo de Geoide predefinido. 


b. Selecione GEOID03 (Conus) na lista. 


O Gerenciador do sistema de coordenadas é um utilitário independente que 
proporciona acesso ao seu banco de dados do sistema de coordenadas 
(Current.csd). No Gerenciador do sistema de coordenadas, modelos de 
geoide podem ser predefinidos. O modelo de geoide predefinido é selecionado 
na caixa de diálogo Selecionar modelo de geoide. 


c. Clique no botão Encerrar. 


A caixa de diálogo Configurações do projeto é exibida mostrando as informações 
da coordenada selecionada na seção Resumo do painel Sistema de coordenadas. 


2b. Selecionar configurações de unidades 
Você usará as configurações de Unidades para selecionar as configurações de unidade 
de coordenada, distância e horário do GPS que deseja usar para seu projeto. 
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1. No painel de navegação (esquerdo) na caixa de diálogo Configurações de projeto, 
selecione Unidades > Coordenada . Então, na lista suspensa Ordem da exibição, 
selecione Direção norte, Direção leste, Elevação. 


 


2. No painel de navegação na caixa de diálogo Configurações de projeto, selecione 
Unidades > Distância. Então, na lista suspensa Exibir, selecione Metro. Na lista 
suspensa Definição de pé, selecione Pé de levantamento americano. 


3. No painel de navegação na caixa de diálogo Configurações de projeto, selecione 
Unidades > Horário do GPS. Então, na lista suspensa Exibir, selecione GPS. 


 


2c. Selecionar configurações de processamento da linha de 
base 


A seguir, você inserirá valores horizontal e vertical que, se ultrapassados, farão as linhas 
de base processadas serem sinalizadas ou falharem totalmente. 


1. No painel de navegação (esquerdo) na caixa de diálogo Configurações de projeto, 
selecione Processamento de linha de base > Qualidade. 


 


2. Insira as propriedades de Critérios de aceitação como segue: 


a. Marque a caixa de seleção Se precisão horizontal e insira os seguintes 
valores: 
- Sinalizador: 0,020 m + 1,0 ppm 
- Falha: 0,050 m + 1,0 ppm 


b. Marque a caixa de seleção Se precisão vertical e insira os seguintes valores: 
- Sinalizador: 0,050 m + 1,0 ppm 
- Falha: 0,100 m + 1,0 ppm 
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2d. Selecionar as configurações de Visualização 
Nesta etapa, você alterará a cor das linhas da quadrícula exibidas na Visualização do 
plano. Você também selecionará para incluir propriedades de grelha/solo na Planilha de 
ponto e os valores de PDOP máximo para vetores pós-processados na Planilha do 
vetor. 


1. No painel de navegação (esquerdo) na caixa de diálogo Configurações de projeto, 
selecione Visualizar > Definição da linha da quadrícula. 


 


2. Na lista suspensa Cor da linha, selecione Magenta. 


Isso mudará as linhas da quadrícula exibidas na Visualização do plano para 
magenta, tornando-as fáceis de ver se você estiver, por exemplo, visualizando 
fotografias.  


3. No painel de navegação na caixa de diálogo Configurações de projeto, selecione 
Visualizar > Planilha de pontos. 


 


4. Role para a seção Propriedades da Grelha/Solo e selecione para mostrar o Fator 
de escala combinado na Planilha de pontos. 
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5. No painel de navegação (esquerdo) na caixa de diálogo Configurações de projeto, 
selecione Visualizar > Planilha de vetor. 


 


6. Role para a seção Dados observados e selecione para mostrar o valor PDOP 
máximo na Planilha do vetor. 


7. Clique em OK. 


Você conclui a seleção das configurações do projeto. A seguir, você verá algumas 
opções de personalização. 


Etapa 3. Definir as opções de exibição e 
personalização 


Ao iniciar um novo projeto, você deve verificar se as opções de exibição estão definidas 
corretamente.  


1. Selecione Ferramentas > Opções. 
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A caixa de diálogo Opções é exibida. 


 


Você pode alterar qualquer uma das opções neste diálogo para aperfeiçoar sua 
visualização ao trabalhar nas diversas exibições no programa. Observe que 
quaisquer alterações feitas persistirão, independentemente dos projetos abertos, até 
que você faça outra alteração. 


2. Clique no botão Avançado para visualizar a caixa de diálogo Opções Avançadas 
de Gráfico. 


Este diálogo permite controlar como os gráficos (por exemplo, fotografias) são 
exibidos no seu projeto. Se um arquivo de imagem muito grande não for exibido 
corretamente devido a restrições de memória, você pode tentar usar este diálogo 
para selecionar um tamanho reduzido que possibilitará a exibição correta. Para este 
tutorial, você não fará nenhuma alteração. 


3. Clique em Cancelar para fechar a caixa de diálogo Opções Avançadas de Gráfico. 
Então clique em Cancelar para fechar a caixa de diálogo Opções. 


4. Selecione Ferramentas > Personalizar. 
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A caixa de diálogo Personalizar é exibida. 


 


Reserve um momento para explorar as diversas guias e botões neste diálogo. (Não 
há necessidade de fazer alterações neste momento.) 


 Guia Barras de ferramentas - Selecione essa guia para especificar quais 
barras de ferramentas são exibidas e criar novas barras de ferramentas. 


 Guia Comandos - Selecione essa guia "arrastar e soltar" os comandos 
diretamente para um menu ou barra de ferramentas e reorganizar os comandos 
de menu e botões da barra de ferramentas. 


 Guia Opções - Selecione essa guia para personalizar o visual dos menus e 
barras de ferramentas. 


 Guia Ferramentas personalizadas - Selecione essa guia para criar comandos 
para abrir outras ferramentas instaladas no seu computador. 


 Guia Salvar/carregar - Selecione essa guia para criar e salvar layouts de menu 
e barra de ferramentas. 


 Botão Teclado - Clique nesse botão para gerenciar atalhos do teclado. 


5. Clique em Fechar para fechar a caixa de diálogo Personalizar. 


Agora é uma boa hora para salvar seu projeto e dar um nome a ele. 
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Etapa 4. Salvar seu projeto 
1. Selecione Arquivo > Salvar projeto .Ou clique no ícone Salvar projeto  na 


barra de ferramentas. 


2. Na caixa de diálogo Salvar como, navegue para ..\Meus documentos\Trimble 
Business Center, que é o local típico para armazenar arquivos de projeto no 
computador. 


3. No campo Nome do arquivo, insira Setting Up a Project YourName.vce. Em 
seguida, clique em Salvar. 


A janela Trimble Business Center exibe o nome do novo projeto na barra de títulos. 


 


O próximo procedimento explica como salvar seu novo projeto em um modelo que possa 
ser usado para outros projetos. 


Etapa 5. Criar um modelo de projeto 
Se você espera criar projetos futuros localizados dentro da mesma área geográfica para 
serem usados para seu novo projeto, você pode salvar suas configurações de projeto 
como um modelo de projeto. 


1. Selecione Arquivo > Salvar o projeto como modelo.  


A caixa de diálogo Salvar o projeto como modelo é exibida. 


 


2. No campo novo Nome, insira Configurando modelo. 
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Você pode marcar a caixa de seleção Salvar projeto como modelo padrão para 
especificar que novos projetos assumam como padrão o uso desse modelo de 
projeto. 


Não há necessidade de salvar um modelo de projeto com base nesse tutorial. Assim, 
na próxima etapa, em vez de clicar em Salvar como normalmente faria para salvar o 
modelo, você pode clicar em Fechar. 


Observação: Depois de salvar um modelo, você pode continuar modificando-o 
conforme o necessário (por exemplo, alterar as configurações de projeto adicionais). 
Essas modificações seriam inclusas no modelo na próxima vez em que usá-lo. 


3. Clique em Fechar para fechar a caixa de diálogo sem salvar o modelo. 


4. Selecione Arquivo > Fechar projeto. 
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Sobre este tutorial 
Neste tutorial, você visualizará planilhas, criará um conjunto de seleção e trabalhará com 
controles COGO. 


Observação: Se você precisar de ajuda adicional em qualquer momento em que estiver 
usando o software, pressione F1 para exibir para a ajuda online. 


Etapa 1. Abra um projeto 
Para esse tutorial, você usará o arquivo de projeto Using Spreadsheets.vce. Os dados 
do GNSS, da estação total e de nível já foram importados para o projeto, e as linhas de 
base do GNSS foram processadas. 


1. Na barra de menu do Trimble Business Center, selecione Arquivo > Abrir 
projeto. Ou clique no ícone Abrir projeto  na barra de ferramentas. 


2. Na caixa de diálogo Abrir arquivo, navegue para C:\Trimble 
Tutorials\TBC\Projects\ Using Spreadsheets.vce e clique em Abrir. 


Se você instalou o tutorial em um local que não o padrão mostrado aqui, navegue 
para esse local. 
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O projeto abre na janela Trimble Business Center. 


 


Observação: Esta figura mostra a Visualização de plano com um plano de fundo 
branco. Seu plano de fundo pode ser preto. Se desejar alterá-lo para branco, 
selecione Ferramentas > Opções e selecione Cor do plano de fundo: Branco na 
caixa de diálogo Opções. 


O arquivo de projeto é somente leitura. Você pode realizar as etapas do tutorial sem 
salvar o arquivo do projeto. Entretanto, se você for interrompido enquanto estiver 
realizando o tutorial, pode salvá-lo selecionando Arquivo > Salvar projeto como e 
salvando em ..\Meus documentos\Trimble Business Center, que é o local típico para 
armazenar arquivos de projeto no seu computador. Então você pode reabrir o projeto 
para continuar o tutorial mais tarde. 


Agora você está pronto para explorar alguns dos recursos do Trimble Business Center. 


Etapa 2. Visualizar planilhas 
Nesta etapa, você visualizará duas planilhas disponíveis no Trimble Business Center: 


 Planilha de Ocupação 


 Planilha de pontos 


Você pode personalizar o que é exibido nas planilhas e como é exibido, como mostrado 
nas etapas a seguir.  
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1. Selecione Projeto > Configurações do Projeto. Ou clique no ícone Configurações 
de projeto  na barra de ferramentas. 


2. No painel de navegação (esquerdo) na caixa de diálogo Configurações de projeto, 
selecione Visualizar > Planilha de pontos. 


Uma lista de nomes de coluna disponíveis para a planilha Pontos é exibida na 
tabela. Cada nome de coluna é seguido por um indicador de se a coluna deve ser 
incluída na planilha. 


 


Você pode clicar em qualquer um dos indicadores Mostrar/Ocultar para alterar a 
seleção. 


No painel de navegação (esquerdo) na caixa de diálogo Configurações do projeto, 
você pode selecionar outras planilhas no menu Visualizar para ver e alterar as 
configurações da coluna Mostrar/Ocultar para elas também. Para este tutorial, não 
há necessidade de fazer alterações. 


3. Clique em Cancelar para fechar a caixa de diálogo Configurações do projeto. 


A seguir, você verá como personalizar uma planilha classificando as suas linhas. 


4. Selecione Visualizar > Nova planilha de pontos. Ou clique no ícone Nova planilha 
de pontos  na barra de ferramentas. 


Uma nova Planilha de pontos é exibida . 
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Você pode classificar as linhas na planilha com base no cabeçalho da coluna 
selecionada. Por padrão, as linhas são classificadas em ordem alfabética crescente 
com base no Ponto ID. 


5. Clique no cabeçalho da coluna Elevação para classificar as linhas com base na 
elevação ascendente e descendente dos pontos. 


Observe que o ícone Classificar  indica se a classificação está na ordem 
crescente (a seta aponta para cima) ou descendente (a seta aponta para baixo). 


Você pode filtrar as linhas exibidas clicando no ícone de filtro  para uma coluna e 
selecionando o filtro adequado. O filtro padrão é Tudo. 


6. Clique no ícone de filtro Código de característica  e selecione SemEspaço no 
menu de contexto. 


 


Apenas pontos com códigos de característica atribuídos são exibidos na planilha. 


Você pode personalizar ainda mais sua planilha como segue: 


 Redimensionar a largura de qualquer coluna colocando o cursor sobre a 
margem da coluna na linha do cabeçalho e arrastando para esquerda ou para a 
direita. 


 Mova uma coluna para um novo local usando "arrastar e soltar". 


 Mova a guia da planilha para um novo local. Simplesmente clique no rótulo da 
guia e arraste-o para baixo para fora da barra da guia antes de soltar. Então 
selecione uma opção de local no menu de contexto. 


Tente selecionar Novo grupo de guia vertical para exibir a guia verticalmente 
na janela. 


Use o mesmo procedimento para mover a guia de volta. 


Qualquer conteúdo exibido em azul na planilha pode ser editado. Por exemplo, você 
pode digitar um novo Ponto ID, ou editar um Código de característica diretamente 
na coluna ou clicando em  para exibir a caixa de diálogo Editor de código de 
característica. 


Você pode copiar linhas de uma planilha para uma planilha Microsoft Excel. Apenas 
selecione as linhas que deseja copiar, pressione Ctrl+C para copiar, selecione uma 
célula na planilha do Excel e pressione Ctrl+V para colar. Embora a linha de 
cabeçalho não possa ser selecionada, ela sempre é copiada e colada sobre a 
planilha junto às linhas selecionadas. 


Você pode exibir o painel Propriedades para qualquer ponto selecionando a linha, 
clicando com o botão direito e selecionando Propriedades no menu de contexto. 


Filtros padrão permitem selecionar os critérios para filtrar dados exibidos em uma 
planilha. No exemplo a seguir, você selecionará visualizar apenas os pontos que não 
usam o tipo de antena R8 GNSS/SPS88x Interno. 
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7. Selecione Visualização > Nova Planilha de Ocupação  Ou clique no ícone Nova 
planilha de ocupação  na barra de ferramentas. 


Uma nova Planilha de ocupação é exibida. 


 


8. Clique no ícone de filtro Tipo de  antena  e selecione Personalizado no menu de 
contexto. 


A caixa de diálogo Inserir critérios de filtro para Tipo de antena é exibida. 


 


9. Na lista suspensa Operador, selecione Não é igual a. 


10. Na lista suspensa Operando, selecione R8 GNSS/SPS88x Interno. Então clique em 
OK. 


A planilha é atualizada com base no seu filtro personalizado. Apenas pontos que não 
usaram o tipo de antena R8 GNSS/SPS88x Interno são exibidos. 


 
Você concluiu a visualização de planilhas. A seguir, você verá como criar e usar 
conjuntos de seleção. 







 Etapa 3. Criar um conjunto de seleção  


Tutorial Trimble Business Center – Usando planilhas, conjuntos de seleções e controles COGO 8 


Etapa 3. Criar um conjunto de seleção 
Se você precisar selecionar os mesmos objetos repetidamente, pode ser cansativo fazê-
lo manualmente, e será fácil cometer erros. Em vez disso, é possível usar o Explorador 
de seleção para criar conjuntos de seleção reaproveitáveis. 


1. Clique na Visualização do plano. 


2. Use o ícone da barra de ferramentas Mais zoom  para ampliar a visualização 
como mostrado aqui. Ou clique na Visualização do plano e use a roda do mouse 
para aproximar o zoom. Pressione a roda do mouse e mova o mouse para o centro 
dos pontos. 


 


3. Selecione Visualização > Explorador de Seleção. Ou clique no ícone Explorador 
de seleção  na barra de ferramentas. 
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O painel Explorador de seleção é exibido. 


 


O Explorador de seleção contém duas listas: 


 A lista Conjuntos de seleção na metade superior do painel. 


 A lista de objetos na metade inferior do painel, que mostra os objetos 
selecionados na Visualização do plano ou que estão contidos no(s) conjunto(s) 
de seleção selecionado. 


4. Na Visualização do plano, use seu cursor para desenhar uma caixa de seleção em 
torno do grupo de objetos que deseja incluir no conjunto de seleção, como mostrado 
aqui. 
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Suas seleções são exibidas no Explorador de seleção na lista de objetos <Captura 
Instantânea de Seleção>. 


 


5. Na barra de ferramentas Explorador de seleção, clique no ícone Salvar a lista de 
seleção como . 


6. Na caixa de diálogo Salvar <Captura Instantânea de Seleção> como, insira o 
nome para o seu conjunto de seleção: NomeDaSuaSeleção. Então clique em OK. 


Seu novo conjunto de seleção é adicionado à lista Conjuntos de seleção. Para 
visualizar os objetos contidos no conjunto de seleção, simplesmente selecione o 
conjunto na lista Conjuntos de seleção. 
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Você pode visualizar as propriedades para qualquer objeto no conjunto de seleção 
selecionando-o na lista, clicando com o botão direito e selecionando Propriedades 
no menu de contexto. Para selecionar múltiplos objetos, use Ctrl + clique ou Shift + 
clique. Selecionar múltiplos objetos pode ser particularmente útil se você deseja 
especificar uma propriedade (por exemplo, um código de característica) para todos 
eles ao mesmo tempo. 


Para selecionar objetos em diversos conjuntos de seleção, pressione a tecla Ctrl e 
faça sua seleção na lista Conjuntos de seleção. 


Você pode usar os outros ícones no Explorador de seleção para visualizar as 
propriedades para os objetos selecionados, remover conjuntos de seleção e 
adicionar ou remover objetos nos conjuntos de seleção. Para obter instruções, 
consulte a Ajuda online. 


7. Feche o painel Explorador de seleção. 


Você concluiu o trabalho com conjuntos de seleção. A seguir, você verá alguns controles 
COGO úteis. 


Etapa 4. Trabalhar com controles COGO 
Os controles COGO (COordinate GeOmetry) são as caixas em vários comandos que 
ajudam você a calcular ângulos, orientações, coordenadas, distâncias, elevações e 
offsets no seu projeto. Eles possibilitam que você insira dados de formas variadas, 
incluindo: 


 Digitar valores e IDs de pontos na caixa 


 Selecionar pontos em visualizações gráficas 


 Clicar com o botão direito em visualizações gráficas e selecionar snap adicional e 
opções COGO a partir do menu de contexto 


Os controles COGO oferecem essa flexibilidade, assim você tem várias formas de inserir 
dados dentro de um único comando, ao invés de forçar você a trabalhar através de 
comandos múltiplos. 


Os comandos snap COGO usam cálculos geométricos para ajudá-lo a especificar as 
coordenadas de maneira mais fácil e precisa. Os comandos snap podem calcular um 
ponto snap usando a geometria existente ou usando parâmetros que você insere. Os 
comandos snap estão disponíveis a qualquer momento em que você precise inserir uma 
coordenada. Simplesmente clique com o botão direito para ver as opções. 


No procedimento a seguir, você criará quatro novos pontos no seu projeto (1, 2, 6 e 7) 
usando os diversos controles COGO e comandos snap disponíveis no Trimble 
Business Center. Entretanto, antes de criar novos pontos, deve verificar se as opções 
do modo snap estão definidas corretamente. 


1. Clique no botão Snap na barra de status na parte inferior da janela do Trimble 
Business Center. 
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A caixa de diálogo Executando as opções do modo snap é exibida. 


 


Essa caixa de diálogo permite especificar as opções do modo snap. A descrição 
para cada opção é exibida na caixa de diálogo. 


No procedimento, você usará os comandos snap para selecionar os pontos. Para 
garantir que você está selecionando um ponto, e não uma coordenada perto de um 
ponto, você desmarcará o modo Livre. Entretanto, porque essa seleção é uma 
configuração do sistema e não específica do projeto, você selecionará novamente 
Livre quando tiver concluído esse procedimento. 


2. Na caixa de diálogo Opções de Modo Snap em Execução, faça o seguinte: 


a. Verifique se a opção de modo Ponto está selecionada. 


b. Desmarque a opção de modo Livre. 


c. Clique em OK. 


3. Crie o ponto 1 como segue: 


a. Selecione Ponto > Criar ponto. 


O painel Criar ponto é exibido. 


 


b. Certifique-se de que o campo Ponto ID exibe 1, o campo Código de 
característica está vazio e o campo Tipo de coordenada exibe Quadrícula. 


c. Clique com o botão direito no campo Direção norte. 


d. No menu de contexto, selecione Orientação Snap de Distância. 







 Etapa 4. Trabalhar com controles COGO  


Tutorial Trimble Business Center – Usando planilhas, conjuntos de seleções e controles COGO 13 


O painel Orientação Snap de distância é exibido. Esses controles permitem 
calcular um ponto com base em um ponto de início, uma orientação e uma 
distância. A orientação zero (0) é norte; as orientações usam azimutes de 
quadrícula medidos no sentido horário. 


 


e. Clique no campo Ponto de referência e depois no ponto 5 na Visualização do 
plano. 


A coordenada para o ponto 5 é exibida no campo. Como alternativa, você pode 
simplesmente digitar 5 no campo. 


f. No campo Orientação, insira S37 44 56E (ou o campo Azimute = 142 15 04). 


g. No campo Distância, insira 290,91sft. Então clique em OK. 


Observe que o valor especifica a unidade de distância sft. Isso é necessário se 
um valor que você deseja inserir usa uma unidade de distância especificada na 
caixa de Configurações de projeto. 


As coordenadas para o novo ponto 1 são exibidas no painel Criar ponto. 


 


h. Clique no botão Adicionar. 
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O novo ponto 1 é exibido na Visualização do plano. O painel Criar ponto foi 
limpo, de modo que você pode criar outro ponto novo. 


 


4. Crie o ponto 2 como segue: 


a. No painel Criar ponto, certifique-se de que o campo Ponto ID exibe 2. 


b. Clique com o botão direito no campo Direção norte. 


c. No menu de contexto, selecione Orientação Snap de Distância. 


O painel Orientação Snap de distância é exibido. 


 


d. No campo Ponto de referência, insira 3. 


e. No campo Orientação, insira N18 05 08E. 


f. No campo Distância, insira 322,91sft. Então clique em OK. 


As coordenadas para o novo ponto 2 são exibidas no painel Criar ponto. 


g. Clique no botão Adicionar. 
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O novo ponto 2 é exibido na Visualização do plano. 


 


Agora você está pronto para criar um novo ponto 6, que estará localizado a meio 
caminho entre os pontos 1 e 2. 


5. Crie o ponto 6 como segue: 


a. No painel Criar ponto, insira 6 no campo Ponto ID. 


b. Clique com o botão direito no campo Direção norte. 


c. No menu de contexto, selecione Meio do snap de ponto a ponto. 


O painel Meio do snap de ponto a ponto é exibido. Esses controles permitem 
calcular um meio caminho de local entre dois pontos. 


 


d. No campo Do ponto, insira 1. 


e. No campo Ao ponto, insira 2. Então clique em OK. 


As coordenadas para o novo ponto 6 são exibidas no painel Criar ponto. 


f. Clique no botão Adicionar. 
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O novo ponto 6 é exibido na Visualização do plano. 


 


Agora você está pronto para criar um novo ponto 7. 


6. Crie o ponto 7 como segue: 


a. No painel Criar ponto, certifique-se de que 7 é exibido no campo Ponto ID. 


b. Clique com o botão direito no campo Direção norte. 


c. No menu de contexto, selecione Orientação do snap de orientação. 


O painel Orientação Snap de Orientação é exibido. Esses controles permitem 
calcular a interseção de duas orientações definida por um primeiro ponto e um 
segundo ponto. 


 


d. No campo Ponto de referência 1, insira 5. 


e. Clique com o botão direito no campo Orientação 1. 


f. No menu de contexto, selecione Orientação + Snap de ângulo. 
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O painel Orientação + Snap de ângulo é exibido. Use esses controles para 
calcular uma orientação adicionando um ângulo a uma orientação específica. 


 


g. Clique com o botão direito no campo Orientação. 


h. No menu de contexto, selecione Snap de orientação ponto a ponto. 


O painel Snap de orientação ponto a ponto é exibido. Use esses controles 
para calcular a orientação de um ponto a outro. 


 


i. No campo Ponto de referência 1, insira 5. 


j. No campo Ponto de referência 2, insira fsi. Então clique em OK. 


O painel Orientação + Snap de ângulo é exibido mostrando a nova Orientação 
1. 


 


k. No campo Ângulo, insira 5 (para 5 graus). Então clique em OK. 
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O painel Orientação Snap de Orientação é exibido. 


 


l. No campo Ponto de referência 2, insira 3. 


m. Clique com o botão direito no campo Orientação 2. 


n. No menu de contexto, selecione Snap de orientação ponto a ponto. 


O painel Snap de orientação ponto a ponto é exibido. 


 


o. No campo Ponto de referência 1, insira 3. 


p. No campo Ponto de referência 2, insira 6. Então clique em OK. 
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O painel Orientação de snap de orientação é exibido mostrando a nova 
Orientação 2. 


 


q. Clique em OK. 


As coordenadas para o novo ponto 7 são exibidas no painel Criar ponto. 


 


r. Clique no botão Adicionar. 
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O novo ponto 7 é exibido na Visualização do plano. 


 


Agora você pode selecionar novamente a opção modo snap Livre caso precise que 
ela esteja ativada para outros projetos. 


7. Selecione novamente a opção de modo snap Livre como segue: 


a. Clique no botão Snap na barra de status na parte inferior da janela do Trimble 
Business Center. 


b. No diálogo Executando opções do modo snap, selecione Livre. 


c. Clique em OK. 


Você concluiu o trabalho com controles COGO. Sinta-se à vontade desta vez para 
continuar explorando o software Trimble Business Center. Pressione F1 a qualquer 
momento para visualizar a Ajuda online associada. 


8. Quando tiver concluído a exploração, selecione Arquivo > Fechar projeto. 


A caixa de diálogo Salvar alterações é exibida. Se você salvou o projeto em um 
novo local ou com um novo nome, pode clicar em Sim. Caso contrário, clique em 
Não. 
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Sobre este tutorial 
Um "corredor" é um gabarito 3D de uma estrutura linear, como uma estrada ou hidrovia. 
O corredor é baseado em um alinhamento horizontal e (opcionalmente) vertical e inclui 
gabaritos que definem seções transversais em toda sua extensão. 


Neste tutorial, você criará um corredor de estrada com base em uma superfície e 
alinhamento existentes. 


Observações:  


 Para criar um corredor com camadas de material como descrito neste tutorial, você 
deve estar executando o software Trimble Business Center com a licença de 
produto Survey Advanced. A licença de produto Survey Standard permite apenas 
criar um corredor sem camadas de material. Para verificar a licença do produto para 
sua instalação, selecione Help > About Trimble Business Center e clique no botão 
Licença. Os recursos licenciados são exibidos na lista Recursos. 


 Se você precisar de ajuda adicional em qualquer momento em que estiver usando o 
software, pressione F1 para exibir para a ajuda online. 


 


Etapa 1. Abra um projeto 
Para esse tutorial, você usará o arquivo de projeto Working with Corridors.vce. Esse 
projeto contém uma superfície e um alinhamento a serem usados para criar um novo 
corredor de estrada. 


1. Na barra de menu do Trimble Business Center, selecione Arquivo > Abrir 
projeto. Ou clique no ícone Abrir projeto  na barra de ferramentas. 


2. Na caixa de diálogo Abrir arquivo, navegue para C:\Trimble 
Tutorials\TBC\Projects\Working with Corridors.vce e clique em Abrir. 


Se você instalou o tutorial em um local que não o padrão mostrado aqui, navegue 
para esse local. 
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O projeto abre na janela Trimble Business Center. 


 


Observação: Esta figura mostra a Visualização de plano com um plano de fundo 
branco. Seu plano de fundo pode ser preto. Se desejar alterá-lo para branco, 
selecione Ferramentas > Opções e selecione Cor do plano de fundo: Branco na 
caixa de diálogo Opções. 


O arquivo de projeto é somente leitura. Você pode realizar as etapas do tutorial sem 
salvar o arquivo do projeto. Entretanto, se você for interrompido enquanto estiver 
realizando o tutorial, pode salvá-lo selecionando Arquivo > Salvar projeto como e 
salvando em ..\Meus documentos\Trimble Business Center, que é o local típico para 
armazenar arquivos de projeto no seu computador. Então você pode reabrir o projeto 
para continuar o tutorial mais tarde. 


Etapa 2. Selecione o tipo de proporção do declive 
para o projeto. 


Porque os corredores incluem declives, você deve verificar se o tipo de proporção de 
declive para seu projeto está correto. O tipo pode ser vertical para horizontal ou 
horizontal para vertical. 


1. Selecione Projeto > Configurações do Projeto. 
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2. Na caixa de diálogo Configurações do projeto, selecione Unidades > Ângulo 
vertical no painel de navegação esquerdo. 


 


Observe que o Tipo de índice de declive é definido como Vertical para horizontal. 
Essa é a configuração que você deseja usar para este tutorial, então não é 
necessário fazer alterações. 


3. Clique no botão Cancelar. 
 


Etapa 3. Filtrar a exibição 
Para melhor visualizar o alinhamento e a superfície incluídos no projeto, pode filtrar a 
visualização para ocultar os vetores e os pontos RTK. 


1. Selecione Visualizar > Gerenciador do filtro de visualização. 


O painel Gerenciador do filtro de visualização mostra que todos os objetos de 
Dados não processados estão selecionados para exibição. 


 


2. Na lista Dados não processados, desmarque Vetor RTK e o Ponto. 
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Você pode ver a alteração na Visualização do plano. 


 


3. Feche o painel Gerenciador do filtro de visualização pane. 
 


Etapa 4. Criar nomes de nó do gabarito 
Antes de criar um novo corredor, você pode criar nomes que serão usados para 
identificar nós em gabaritos de seção transversal de corredor. 


Você também criará nomes de nó de gabarito quando você estiver criando gabaritos de 
corredor, mas criá-los antecipadamente pode ajudar a acelerar o processo de criação de 
gabarito. Também permite criar uma biblioteca de nomes de nó que podem ser usados 
repetidamente em cada um dos seus projetos. Simplesmente crie os nomes que pode 
precisar, então salve seu projeto como um modelo. Os nomes estarão disponíveis para 
qualquer projeto criado usando o modelo. Para instruções sobre a criação dos modelos 
de projeto, consulte o tutorial Configurando um novo projeto. 


Nesse procedimento, você criará dois novos nomes de nó de modelo. 


1. Selecione Corredor > Gerenciar nomes de nó do gabarito. Ou clique no ícone 
Gerenciar nomes de nó do gabarito  na barra de ferramentas. 


2. No painel Gerenciar nomes de nó do modelo, clique no botão Novo localizado na 
parte inferior do painel. (Você pode precisar rolar para baixo para ver.) 


Uma nova linha é exibida na lista. 
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3. Insira Pista de rodagem.  


4. Repita as etapas 2 e 3 para criar o Ponto de junção do nome. 


5. Clique no botão Fechar. 


Em seguida, você criará uma nova camada de material para o corredor. 


Etapa 5. Criar camadas de material 
Você pode especificar as camadas de material disponíveis no seu projeto, cada uma 
representando uma superfície diferente dentro do corredor. Por exemplo, além da 
camada "Finalizar" padrão, você pode especificar camadas para "Curso básico", 
"Revestimento estabilizado" e "Revestimento". 


Toda vez que criar uma instrução de gabarito de corredor (como descrito neste tutorial), 
é possível selecionar uma ou mais camadas de material na qual aparece o segmento de 
linha criado por essa instrução. 


Ao criar ou editar um corredor, é possível especificar sua "camada atual de material" 
selecionando-a na lista Camadas. Essa é a camada que aparecerá na Visualização do 
plano e na Visualização 3D. Se exportar o corredor, essa é a camada usada para criar 
a superfície do corredor exportado. Os segmentos de linha que aparecem na camada 
atual de material são usados para construir a superfície do corredor. 


Neste procedimento, você criará uma nova camada de material para usar no corredor. 


1. Selecione Corredor > Gerenciar camadas de material. Ou clique no ícone 
Gerenciar camadas de material  na barra de ferramentas. 


O painel Gerenciar camadas de material é exibido. A camada padrão Encerrar é 
exibida na lista Camadas de material. 


 


2. Clique no botão Novo. 


Uma nova linha é exibida na lista Camadas de material. 


3. No campo Nome, insira Revestimento. 


4. Clique no botão Fechar. 


Agora você está pronto para criar um novo corredor. 


Etapa 6. Criar um corredor. 
Neste procedimento, você criará um corredor para uma estrada que deve ser construído 
com base na superfície e alinhamento contidos no projeto. 
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1. Selecione Corredor > Criar Corredor. Ou clique no ícone Criar Corredor  na 
barra de ferramentas. 


O painel Criar corredor é exibido. 


 


2. No campo Nome, insira Estrada01. 


CL é o único alinhamento no projeto, então ele é selecionado por padrão nas listas 
suspensas Alinhamento horizontal e Alinhamento vertical. 


3. Na lista de camada Material atual, selecione Encerrar. 


Essa é a camada que aparecerá na Visualização do plano e na Visualização 3D. 


Agora você selecionará uma polilinha CAD inclusa no projeto a ser usada como linha 
de referência no novo corredor. Você poderá criar offsets no corredor com base 
nessa linha. 


4. Clique no botão +/-. 


O painel Editar linhas de referência é exibido. 


 


5. Clique no campo Selecione as linhas a serem adicionadas ou removidas:. Então 
clique na polilinha CAD verde-água na Visualização do plano. No menu de 
contexto, selecione Polilinha CAD. 
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Se necessário, use a roda do mouse para ver melhor a linha. 


 


O campo mostra que um item está selecionado. 


 


6. Clique no botão Adicionar. 


É exibida uma mensagem dizendo que o item selecionado foi adicionado como uma 
linha de referência ao novo corredor. 


7. Clique no botão Fechar. 


A quantidade de linhas de referência a serem incluídas no corredor é exibida no 
painel Criar corredor. 


 


8. Na lista Superfícies de referência, marque a caixa de seleção existente. 


9. Clique em OK. 
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O painel de comando Inserir gabarito de corredor é exibido. 


 


A seguir, você inserirá um gabarito de seção transversal ao novo corredor. 


Etapa 7. Inserir um gabarito de corredor 
Você pode criar e inserir um ou mais gabaritos de seção transversal em um corredor. 
(Entretanto, você não pode inserir mais de um gabarito na mesma estação.) Cada 
gabarito inclui instruções que definem seções transversais para um comprimento 
especificado do corredor (por exemplo, os diversos offsets e declives para uma estrada). 


Neste procedimento, você criará um único gabarito que define o corredor da estação 
0+00 em diante. 


1. No painel Inserir gabarito de corredor, certifique-se de que Estrada01 esteja 
selecionado na lista suspensa Corredor. 


2. No campo Estação inicial, insira 0. 


Observe que quando você move o cursor do campo, 0 muda para o formato de 
estacionamento padrão: 0+00,00. Isso indica que o novo gabarito será inserido na 
estação 0+00,00 no corredor e será usado para definir o corredor da estação ao 
próximo gabarito, ou, se não houver nenhum, até o final do corredor. 


3. Na lista suspensa Opções, certifique-se de que Nova definição esteja selecionada. 
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4. No campo Nome do gabarito, insira Gabarito01. 


 


5. Clique no botão Inserir. 


O painel Editar gabarito de corredor é exibido. O painel inclui três seções: (1) uma 
guia de visualização gráfica do gabarito, (2) uma lista de Instruções e (3) uma 
seção de propriedades da instrução. 
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Na guia de visualização gráfica, a linha verde representa a superfície no projeto. O 
nó da linha central 1[CL], que é baseado no alinhamento horizontal, foi 
automaticamente criado e adicionado ao gabarito. Você também pode ver que um 
nó 2 foi adicionado (aproximadamente 15 pés à esquerda de 1[CL]) com base na 
única polilinha CAD que você adicionou ao corredor mais cedo. 


 


6. Selecione Visualizar > Explorador do Projeto. Então, no painel Explorador do 
projeto, clique no sinal de mais antes do nó Corredores e no nó Estrada01 para ver 
o novo nó do gabarito. 


 


7. Feche o painel Explorador do projeto. 
 


Etapa 8. Criar instruções para o gabarito do corredor 
Agora que você criou e inseriu um gabarito de seção transversal no novo corredor, é 
possível definir instruções que especifiquem a aparência da seção transversal ao longo 
do comprimento do corredor para o qual o gabarito foi definido: os diversos offsets e 
declives para a estrada. 


Os gabaritos de corredor são compostos por nós e instruções. Os nós são usados para 
definir os diversos offsets e inclinações nos gabaritos. Por exemplo, um simples corredor 
de estrada pode conter três nós: uma linha central baseada no alinhamento (1), um limite 
à direita do pavimento (2) e um limite à esquerda do pavimento (3). 
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O software automaticamente cria alguns nós baseados no alinhamento e nas linhas de 
referência em seu corredor. Por exemplo, o nó 1 na figura acima foi automaticamente 
criado como a linha central para o corredor com base no alinhamento do corredor. 


É possível criar nós adicionais conforme necessário para definir offsets e inclinações 
para outras características do corredor. Por exemplo, o nó 2 na figura acima foi criado 
manualmente para representar o limite à direita do pavimento com um offset de 10 pés e 
uma inclinação de -2% em relação à linha central. Para criar um nó manualmente, você 
define as instruções que especificam o offset e a inclinação do nó em relação a outros 
nós no gabarito. 


Nesse procedimento, você definirá um gabarito de corredor primeiro definindo os nós e 
linhas para o lado direito do corredor para as camadas de material Acabamento e 
Revestimento. Então você usará o comando Espelhar instruções para copiar o mesmo 
nó e layout de linha para o lado esquerdo da linha central. 


8a. Defina pista de rodagem direita – Camada Encerrar 
1. No painel Editar Gabarito do corredor, selecione Offset/Declive na lista suspensa 


Tipo de instrução. 


Esse tipo de instrução permite-lhe criar um nó no gabarito para o qual você 
especifica o offset e o declive em relação a outro nó. Nesse caso, você baseará o 
novo nó no nó CL que foi criado automaticamente para o alinhamento selecionado. 


2. No campo Offset/declive de, selecione <Nó anterior>. 


Se você selecionar <Nó anterior>, o nó criado pela instrução anterior na lista 
Instruções é usado como referência. Se não houver instruções anteriores na lista, 
como neste caso, o nó 1[CL] criado automaticamente para o alinhamento horizontal 
é usado como referência. 


3. No botão Offset, certifique-se de que o ícone Offset  é exibido. Então insira 12 no 
campo. 


Isso especifica que o novo nó será criado 12 pés à direita do nó 1[CL] (linha central). 
Se você inserir -12, o novo nó será criado 12 pés à esquerda do nó 1[CL]. 


4. No botão Declive, clique no ícone suspenso e selecione a opção Tabela . Então 
clique no botão Tabela . 


O painel Tabela de Estação/Declive é exibido. Este painel permite especificar o 
declive entre o nó 1[CL] e o novo nó em nas estações especificadas ao longo do 
corredor a partir do gabarito atual até o próximo gabarito (ou o final do corredor). 


 


5. No painel Tabela de Estação/Declive, insira os seguintes valores. 
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Observação: Você não precisa inserir valores no formato mostrado aqui. Para 
0+00,00, você pode simplesmente inserir 0. Para 4+33,00, você pode inserir 433. 
Para um declive de -2,00%, você pode inserir -2. O formato correto será aplicado 
quando o cursor deixa a célula da tabela. 


Estação Declive 
0+00,00 -2,00% 
0+50,00 -2,00% 
0+75,00 -4,00% 
1+32,00 -4,00% 
1+50,00 -2,00% 
4+33,00 -2,00% 
4+53,00 -4,00% 
5+17,00 -4,00% 
5+36,00 -2,00% 


Uma porcentagem de declive negativa indica a criação do nó abaixo da linha central. 


 


Quando tiver concluído, clique em OK. 


6. Na lista suspensa Nome, selecione Pista de rodagem. 


Esse nó representa a margem direita da pista de rodagem. 


7. Na lista Camadas de material, selecione Encerrar. 


8. Clique no botão Adicionar.  
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O nó recém criado 3[Pista de rodagem] é exibido na visualização gráfica do gabarito. 
A instrução usada para criar o nó é exibida na lista Instruções. Clique na área 
gráfica e use a roda do mouse para aproximar o zoom no novo nó. Observe também 
que o corredor agora é exibido na Visualização do plano. 


 


Os campos na seção de propriedades do painel Editar Gabarito de corredor foram 
criados para permitir a criação de outra instrução. 


8b. Defina o acostamento direito – Camada Encerrar 
1. Na lista suspensa Tipo de instrução, selecione Offset/inclinação. 


2. Preencha os campos Detalhes da instrução como segue: 


 Offset/declive de: <Nó anterior> 
Neste caso, o <Nó anterior> é o recém criado nó 3[Pista de rodagem]. 


 Offset > Offset : 6  


 Declive > Porcentagem de declive : -4 
No botão suspenso Declive, selecione a opção Porcentagem do declive. O 
sinal de menos antes do número indica que o declive está na direção para baixo 
do nó 3[TL]. 


 Nome: Acostamento 
Uma vez que você não inseriu Acostamento como o código do corredor usando 
o Gerenciador de código do corredor, pode digitar no campo Código agora. 
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 Camadas de material: Encerrar 


 


3. Clique no botão Adicionar. 


O nó 4[Acostamento] recém criado representa a margem do acostamento com base 
na margem direita da pista de rodagem. 


 


 


8c. Defina declive de drenagem direito – Camada Encerrar 
1. Na lista suspensa Tipo de instrução, selecione Offset/inclinação. 


2. Preencha os campos Detalhes da instrução como segue: 


 Offset/declive de:  <Nó anterior> 
Neste caso, o <Nó anterior> é o recém criado nó 4[Acostamento]. 


 Offset > Offset : 5 


 Declive > Porcentagem de declive : -20 
No botão suspenso Declive, selecione a opção Porcentagem do declive. O 
sinal de menos antes do número indica que o declive está na direção para baixo 
do nó 4[Acostamento]. 
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 Nome: Valas 
Você precisará digitar esse novo código no campo. 


 Camadas de material: Encerrar 


3. Clique no botão Adicionar. 


O nó 5[Valas] recém criado representa a margem direita do declive de drenagem 
com base na margem direita do acostamento. 


 


Agora você está pronto para definir um declive lateral para o lado direito do gabarito 
do corredor. O tipo de instrução Declive lateral define um nó de declive lateral 
baseado em um ou ambos dos itens abaixo: 


 Inclinação de corte e, opcionalmente, uma largura do fosso 


 Inclinação de aterramento 


O nó de declive lateral especifico a interceptação da inclinação de aterramento ou 
corte com a superfície alvo. 


8d. Defina declive lateral direito – Camada Encerrar 
1. Na lista suspensa Tipo de Instrução, selecione Declive lateral. 


2. Preencha os campos Detalhes da instrução como segue: 


 Declive lateral de: <Nó anterior> 
Neste caso, o <Nó anterior> é o recém criado nó 5[Valas]. 


 Superfície alvo: existente 
Isso permite ao declive lateral se conectar à superfície existente. 


 Declive do corte > Índice do declive : 1:2 
Com base nas configurações de projeto, isso representa um tipo de declive de 
vertical para horizontal. 


 Largura do fosso de escavação 3 
Isso indica que, se um aterro é necessário, uma vala de três pés de largura é 
incluída. 


 Declive de aterro > Índice do declive : 1:5 


 Nome: Ponto de junção  


 Camadas de material: Encerrar 
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3. Clique no botão Adicionar. 


 


Como você pode ver, o declive lateral se estende até que intercepte a superfície, 
que muda ao longo do comprimento do corredor. Dependendo da superfície em 
cada local ao longo do corredor, um corte ou aterro pode ser necessário. Se for 
necessário um aterro, uma vala de três pés de largura é incluída, conforme a 
instrução. 


Você concluiu a definição da camada de material Encerrar para o lado direito do 
gabarito. Em seguida, você definirá a camada de material de Revestimento para o 
lado direito. 


8e. Definir a linha central – Camada de revestimento 
No painel Editar Gabarito do corredor, faça o seguinte: 


1. Na lista suspensa Tipo de instrução, selecione Offset/elevação. 


2. Preencha os campos Detalhes da instrução como segue: 


 Offset/elevação de: 1[CL] 


 Offset > Offset : 0 
O offset 0 garante que o novo nó Revestimento esteja localizado diretamente 
acima ou abaixo do nó 1[CL], dependendo do valor de Elevação. 


 Elevação > Elevação Delta : -.5 
No botão suspenso Elevação, selecione a opção Elevação delta. O sinal de 
menos antes do número indica que o novo nó estará 0,5 pé abaixo do nó 1[CL]. 


 Nome: CL Rev. 
Digite esse novo código no campo. 


 Camadas de material: nada selecionado 
Não selecionando uma camada de material, você pode garantir que uma linha 
não seja criada automaticamente conectando o nó 1[CL] ao novo nó. 


3. Clique no botão Adicionar. 
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O recém criado nó 7[CL Rev] representa a linha central para a camada de material 
de Revestimento. 


 


 


8f. Defina pista de rodagem direita – Camada Revestimento 
1. Na lista suspensa Tipo de instrução, selecione Offset/elevação. 


2. Preencha os campos Detalhes da instrução como segue: 


 Offset/elevação de: 3[Pista de rodagem] 


 Offset > Offset : 0 


 Elevação > Elevação Delta : -.5 


 Nome: Pista de rodagem Rev. 


 Camadas de material: nada selecionado 


3. Clique no botão Adicionar. 


O recém criado nó 8[Pista de rodagem Rev] representa a margem direita da pista de 
rodagem direita para a camada de material de Revestimento. 
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8g. Defina o acostamento direito – Camada Revestimento 
1. Na lista suspensa Tipo de instrução, selecione Offset/elevação. 


2. Preencha os campos Detalhes da instrução como segue: 


 Offset/elevação de: 4[Acostamento] 


 Offset > Offset : 0 


 Elevação > Elevação Delta : -.5 


 Nome: Acostamento Rev 


 Camadas de material: nada selecionado 


3. Clique no botão Adicionar. 


O nó recém criado 9[Acostamento Rev] representa a margem direita do acostamento 
direito da camada de material de Revestimento. 


 


A seguir, você conectará nós de Revestimento recém criados com os segmentos de 
linha. 


8h. Conecte os nós – Camada Revestimento 
Neste procedimento, você definirá um segmento de linha para conectar os nós 7[CL 
Rev.] e 8[TL Rev.]. 


1. Na lista suspensa Tipo de instrução, selecione Conectar. 


2. Preencha os campos Detalhes da instrução como segue: 


 Do nó: 7[CL Rev.]  
Você pode selecionar o nome do nó na lista suspensa ou selecioná-lo na 
visualização gráfica do gabarito. 


 Ao nó:  8[Pista de rodagem Rev.] 


 Camadas de material: Revestimento  
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3. Clique no botão Adicionar. 


 


A seguir, você definirá um segmento de linha para conectar 8[TL Rev.] e 
9[Acostamento Rev.]. 


4. Na lista suspensa Tipo de instrução, selecione Conectar. 


5. Preencha os campos Detalhes da instrução como segue: 


 Do nó: 8[Pista de rodagem Rev.] 


 Ao nó: 9[Acostamento Rev.]  


 Camadas de material: Revestimento 


6. Clique no botão Adicionar. 


 


Agora você está pronto para criar instruções para definir nós e linhas no lado 
esquerdo do nó da linha central 1[CL]. Para este tutorial, o lado esquerdo será 
definido exatamente igual ao direito, então você pode usar o comando Espelhar 
instruções. 


8i. Espelhar instruções no lado direito do gabarito para o lado 
esquerdo. 


1. Clique no ícone Espelhar instruções  localizado na parte superior do painel 
Editar gabarito do corredor. 
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As instruções são copiadas para o lado esquerdo do gabarito de maneira espelhada 
como mostrado aqui. 


 


2. Para ver como o gabarito muda em relação à superfície existente ao longo do 
comprimento do corredor, use o controle deslizante localizado abaixo da lista 
Instruções. 


A estação é exibida no campo à esquerda. 


 
Esse gabarito é completo, e agora é possível inserir gabaritos adicionais no corredor, 
se necessário. Entretanto, você não adicionará mais nenhum gabarito para este 
tutorial. Em vez disso, o próximo procedimento explicará como você pode editar um 
gabarito existente alterando uma instrução. 


3. No painel Editar gabarito do corredor, clique no botão Fechar. 
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Etapa 9. Editar uma instrução 
Nesta etapa, você editará uma instrução no gabarito de corredor recém criado 
redefinindo a margem esquerda da pista de rodagem esquerda para ser baseada em 
uma polilinha CAD adicionada ao projeto como uma linha de referência no tutorial. 
Conforme a polilinha CAD move-se em relação ao seu offset para a linha central, o 
mesmo ocorre com o offset para a margem esquerda da pista de rodagem esquerda. 


1. Na janela do Trimble Business Center, selecione Visualizar > Explorador do 
projeto, ou clique no ícone Explorador do projeto na barra de ferramentas. 


O painel Explorador do projeto é exibido. 


 


2. No painel Explorador do projeto, expanda Corredor, clique com o botão direito no 
nó do gabarito do corredor 0+00,00, Gabarito 01, e selecione Editar. 


O painel Editar gabarito de corredor é exibido. 


 


3. Feche o painel Explorador do projeto. 
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4. Na lista Instruções no painel Editar gabarito do corredor, clique duas vezes na 
instrução 10[Pista de rodagem], ou clique com o botão direito nela e selecione 
Editar. 


 


As propriedades para o nó 10[TL] são exibidas na seção Detalhes da instrução. 
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5. Clique no botão suspenso Offset e selecione a linha 2D . Então selecione o nó 2 
na visualização gráfica. (Use a roda do mouse para aproximar e afastar o zoom, se 
necessário.) 


 


A Polilinha CAD é exibida no campo Offset. 


 


6. Clique no botão Salvar. 


A margem esquerda da pista de rodagem agora depende do local da polilinha CAD. 
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7. Para ver como o gabarito muda em relação à superfície existente e à polilinha CAD 
ao longo do comprimento do corredor, use o controle deslizante localizado abaixo da 
lista Instruções. 


 


 


Etapa 10. Verificar a distância de amostragem máxima 
Gabaritos de corredor criam como uma superfície dividida em partes nos componentes 
horizontal e vertical principais do alinhamento. Partes adicionais são criadas a intervalos 
(distâncias de amostragem) definidos nas configurações do projeto. Nesta etapa, você 
verificará se a configuração da distância de amostragem está correta. 


1. Selecione Projeto > Configurações do Projeto. 
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2. Na caixa de diálogo Configurações do projeto, selecione Cálculos > Corredor no 
painel de navegação. 


 


Você pode reduzir a Distância de amostragem máxima para fazer com que mais 
partes sejam criadas, o que resultaria em uma superfície mais lisa nas curvas 
horizontal e vertical. Entretanto, para esse tutorial você não alterará o valor padrão. 


3. Clique no botão Cancelar. 


Agora você está pronto para exportar o corredor. 


Etapa 11. Exportar o corredor. 
Nesta etapa, você exportará o corredor recém criado como um arquivo RXL. 


1. Selecione Arquivo > Exportar. Ou clique no ícone Exportar  na barra de 
ferramentas. 


2. No painel Exportar, selecione a guia Levantamento. Então selecione Exportador 
da estrada RXL do corredor na lista. 


 


3. No campo Offset esquerdo, insira 50. No campo Offset direito, insira 35. 
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Essas distâncias garantem que a largura de todo o corredor seja incluída na 
superfície exportada. 


 


4. Na seção Nome do arquivo, selecione o botão Mais  e selecione o local para o 
qual deseja exportar o arquivo. 


5. Clique no botão Exportar. 


Você conclui o trabalho com o corredor e agora pode fechar o projeto. 


6. Selecione Arquivo > Fechar projeto. 


A caixa de diálogo Salvar alterações é exibida. Se você salvou o projeto em um 
novo local ou com um novo nome, pode clicar em Sim. Caso contrário, clique em 
Não. 
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Sobre este tutorial 
"Superelevação" é a inclinação de uma rodovia ao longo de uma curva horizontal para 
que os motoristas possam manobrar com segurança e conforto na curva às velocidades 
do projeto. Conforme as velocidades aumentam e as curvas horizontais se tornam mais 
apertadas, é necessária uma superelevação mais íngreme. 


Neste tutorial, você definirá uma superelevação para um alinhamento usado para uma 
estrada curva. Agora você aplicará as propriedades de superelevação à estrada 
conforme as instruções do gabarito de corredor. Por fim, você definirá os parâmetros de 
deslocamento para a estrada para garantir que as diferenças de declive entre os 
segmentos (por exemplo, uma pista de rodagem e um acostamento em uma curva 
superelevada) sejam mantidas a um mínimo por questões de segurança e conforto à 
velocidade do projeto. 


Observações:  


 Para criar uma superelevação como descrito neste tutorial, você deve estar 
executando o software Trimble Business Center com a licença de produto Survey 
Advanced. Para verificar a licença do produto para sua instalação, selecione Help > 
About Trimble Business Center e clique no botão Licença. Os recursos 
licenciados são exibidos na lista Recursos. 


 Se você ainda não sabe como trabalhar com corredores e especificar instruções de 
gabarito de corredor, recomenda-se que você conclua o tutorial Trabalhando com 
corredores antes de continuar com este tutorial. 


 Se você precisar de ajuda adicional em qualquer momento em que estiver usando o 
software, pressione F1 para exibir para a ajuda online. 


 


Etapa 1. Abra um projeto 
Para esse tutorial, você usará o arquivo de projeto Working with Superelevations.vce. 
Esse projeto contém uma superfície, um alinhamento horizontal e vertical e um corredor. 


1. Na barra de menu do Trimble Business Center, selecione Arquivo > Abrir 
projeto. Ou clique no ícone Abrir projeto  na barra de ferramentas. 


2. Na caixa de diálogo Abrir arquivo, navegue para C:\Trimble 
Tutorials\TBC\Projects\Working with Superelevations.vce e clique em Abrir. 


Se você instalou o tutorial em um local que não o padrão mostrado aqui, navegue 
para esse local. 
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O projeto abre na janela Trimble Business Center. 


 


Observação: Esta figura mostra a Visualização de plano com um plano de fundo 
branco. Seu plano de fundo pode ser preto. Se desejar alterá-lo para branco, 
selecione Ferramentas > Opções e selecione Cor do plano de fundo: Branco na 
caixa de diálogo Opções. 


O arquivo de projeto é somente leitura. Você pode realizar as etapas do tutorial sem 
salvar o arquivo do projeto. Entretanto, se você for interrompido enquanto estiver 
realizando o tutorial, pode salvá-lo selecionando Arquivo > Salvar projeto como e 
salvando em ..\Meus documentos\Trimble Business Center, que é o local típico para 
armazenar arquivos de projeto no seu computador. Então você pode reabrir o projeto 
para continuar o tutorial mais tarde. 


Etapa 2. Aplicar superelevação ao alinhamento 
O alinhamento horizontal neste projeto inclui duas curvas em arco, uma das quais inclui 
uma espiral para dentro e uma espiral para fora. Para este tutorial, você começará 
aplicando uma superelevação às duas curvas para definir mudanças de declive 
(inclinação) através da curva. Mais tarde, você adicionará instruções de superelevação a 
um gabarito de corredor. 


Observação: Para uma descrição mais detalhada de superelevações, consulte o tópico 
"Entendendo superelevações" na ajuda online. 







 Etapa 2. Aplicar superelevação ao alinhamento  


Tutorial Trimble Business Center – Trabalhando com superelevações 5 


1. Selecione Visualizar > Explorador do Projeto. 


2. No Explorador do projeto, expanda o nó Alinhamentos . Então clique com o 
botão direito em Superestrada e selecione Editar. 


O painel Editor de alinhamento é exibido na área inferior da janela. 


 


3. Selecione a guia Superelevação à esquerda do Editor de alinhamento. 


Se necessário, use o controle de rolagem da guia para exibir a guia Superelevação 
para seleção. 
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A lista suspensa localizada na parte superior da guia permite selecionar cada curva 
no alinhamento horizontal de modo que você possa definir os parâmetros de 
superelevação para ela. Para cada curva, a estação inicial e o raio para a curva são 
exibidos. 


Você começará definindo os parâmetros de superelevação para a primeira curva no 
alinhamento, que é uma curva em arco simples. 


4. Na lista suspensa, selecione a primeira curva: 12+00,00, raio = 1000,000. Então 
insira os seguintes parâmetros: 


a. No campo Declive transversal normal, certifique-se de que o valor é -2,00%. 


Esse valor representa o declive transversal normal da estrada quando não na 
superelevação e é referido por todas as curvas superelevadas no alinhamento. 
Quaisquer alterações realizadas neste campo afetam todas as curvas 
superelevadas. Se você excluir a inclinação transversal normal, a superelevação 
é removida do alinhamento. 


Observação: O valor da inclinação transversal normal inserido aqui é usado na 
visualização Diagrama de superelevação. O valor não substitui o valor da 
inclinação especificado nas instruções do gabarito de corredor. 


b. No campo Superelevação máxima, insira 6. 


Quando você mover o cursor para outro campo ou pressionar a tecla Tab, o 
valor 6 muda para 6,00%. Essa é a taxa máxima de superelevação da curva em 
termos de inclinação percentual. 


O programa automaticamente insere os valores para os campos no lado direito 
da guia com base em uma superelevação máxima de 6,00% e no fato de que é 
uma curva em arco simples. Porque o arco não possui espiral para dentro e 
espiral para fora, o programa usa os parâmetros de arco para as transições de 
superelevação. Isso significa que não há transição da lomba normal para 
superelevação completa e de volta para a lomba normal. A mudança é abrupta. 
Você corrigirá isso mais tarde. 


 


c. No campo Comprimento da curva vertical, insira 100. 
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Esse valor especifica o comprimento da curva vertical parabólica que será 
aplicado a cada ponto de transição de estação inicial ou final na curva 
superelevada para suavizar a transição. O ponto de transição é a PVI (ponto de 
interseção vertical) para a curva vertical. O software também traça essas curvas 
verticais no diagrama de superelevação nesses pontos de transição. 


Agora você está pronto para definir parâmetros para a segunda curva no 
alinhamento horizontal, que é uma curva em arco com uma espiral para dentro e 
uma espiral para fora. 


5. Na lista suspensa, selecione a segunda curva: 34+00,00, raio = 900,000. Então 
insira os seguintes parâmetros: 


a. No campo Declive transversal normal, certifique-se de que o valor é -2,00%. 


b. No campo Superelevação máxima, insira 6. 


c. No campo Comprimento da curva vertical, insira 100. 


Os valores automaticamente inseridos nos campos no lado direito da guia são 
baseados em uma superelevação máxima de 6,00% e o fato de que essa é uma 
curva em arco com uma espiral para dentro e uma espiral para fora. O programa 
usa os valores de espiral para dentro, arco e espiral para fora para preencher os 
valores de estação de transição de superelevação. 


 


 Início da transição da superelevação especifica a estação na qual a 
transição da lomba normal para a superelevação máxima de declive de 6% 
começa. 


 Início da superelevação máxima especifica a estação na qual a 
superelevação máxima de declive de 6% começa. 


 Fim da transição da superelevação especifica a estação na qual a 
superelevação máxima de declive de 6% termina e a transição de volta à 
lomba normal começa. 


 Fim da transição de superelevação especifica o final da transição para a 
superelevação máxima de declive de 6% de volta para a lomba normal. 


As figuras a seguir mostram a transição da lomba normal para a superelevação 
máxima, e de volta para a lomba normal através de uma curva superelevada. 


Ao aproximar-se: 
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Inicie com lomba normal. 


 
 


Faça a transição para onde a pista externa tem declive transversal zero (plano). 


  
 


Faça a transição para onde a lomba foi removida. 


  
 


Superelevação máxima. 


 
 


Ao sair: 


Faça a transição de volta a onde a lomba foi removida. 


  
 


Faça a transição de volta para onde a pista externa tem declive transversal zero 
(plano). 


  
 


Volte para lomba normal. 


 
 


Agora você verá a superelevação que foi definida na visualização Diagrama de 
superelevação. 
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6. Clique no botão Diagrama de superelevação localizado na parte superior da guia 
Superelevação. Então clique com o botão direito na guia Diagrama de 
superelevação e selecione Mover para o grupo de guias anterior. 


 


O diagrama inclui linhas de grade com relação às quais o perfil da superelevação é 
exibido. As linhas de grade verticais representam estações no alinhamento. As 
linhas de grade horizontais representam os graus da inclinação. As duas linhas 
coloridas, que compõem o perfil da superelevação, representam os limites interno e 
externo da rodovia. O diagrama é atualizado automaticamente conforme as 
alterações são feitas na guia Superelevação. 


Observação: Você pode alterar a escala de plotagem e exagero vertical para o 
diagrama na caixa de diálogo Configurações do projeto. 
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Você pode ver no diagrama que a segunda curva (2 na figura a seguir), que é um 
arco com uma espiral para dentro e uma espiral para fora, inclui uma transição da 
lomba normal para a superelevação máxima e de volta para a lomba normal. A 
primeira curva (1 na figura a seguir) não inclui espirais, então o programa não 
especifica transições para ela. Em vez disso, a curva muda abruptamente de lomba 
normal para superelevação máxima. Você corrigirá isso na próxima etapa. 


 


7. Na lista suspensa na guia Superelevação, selecione a primeira curva: 12+00,00, 
raio = 1000,000. Então insira os seguintes parâmetros: 


a. No campo Início da transição da superelevação, insira 900. 


b. No campo Fim da transição da superelevação, insira 2100. 
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A primeira curva agora mostra uma transição da lomba normal para superelevação 
máxima e de volta para a lomba normal. 


 
Você concluiu a aplicação de superelevação ao alinhamento horizontal. A seguir, você 
adicionará instruções de superelevação a um gabarito de corredor. 


Etapa 3. Adicionar instruções de superelevação a um 
gabarito de corredor. 


1. No Explorador do projeto, expanda o nó Corredores   e o nó 2 Pista. Então 
clique com o botão direito em 0+000, Típico e selecione Editar. 
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O painel Editar gabarito de corredor é exibido. 


 


O gabarito inclui nove instruções que definem nós para as camadas de material 
Encerrar e Revestimento. 


 


Os nós 2[EP] (1 acima) e 5[EP] (2 acima), que são os nós de margem do pavimento 
direito e esquerdo para a camada Encerrar, precisam ser superelevados. Portanto, 
uma instrução de Superelevação deve ser inserida na lista Instruções 
imediatamente a após as duas instruções que definem esses nós. Então, para 
começar, você moverá a instrução que define o nó 5[EP] diretamente para baixo da 
instrução que define o nó 2[EP]. 


2. Na lista Instruções, clique e arraste a instrução que define o nó 5[EP] diretamente 
para baixo da instrução que define o nó 2[EP]. 
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Observe que o nome do nó muda de 5[EP] para 3[EP]. 


 


Agora você pode inserir uma nova instrução de Superelevação imediatamente após 
a instrução que define o nó 3[EP]. 


3. Para inserir uma instrução de superelevação para a camada Encerrar, faça o 
seguinte: 


a. Selecione a instrução que define o nó 3[EP] na lista Instruções. 


b. Clique no ícone Adicionar instrução  localizado na parte superior do painel 
Editar gabarito do corredor. 


c. Na lista suspensa Tipo de instrução, selecione Superelevação. 


d. Na lista Nó da lomba, selecione 1[Superestrada]. 


e. Na lista Nó do pivô, selecione 1[Superestrada]. 


Esse é o nó sobre o qual o declive superelevado irá girar. Esse nó é 
automaticamente adicionado à lista Nós selecionados. 


f. Na lista suspensa Nó selecionado, selecione 2[EP] e clique no botão Adicionar 
para adicioná-lo à lista de nós Selecionados. 


Opcionalmente, clique no campo Nó selecionado e depois selecione o nó 2[EP] 
na visualização gráfica do gabarito. 
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a. Na lista suspensa Nó selecionado, selecione 3[EP] e clique no botão Adicionar 
localizado diretamente abaixo na lista. 


 
b. Na parte inferior do painel Editar gabarito do corredor, clique no botão 


Adicionar. 


A nova instrução de Superelevação é inserida na lista Instruções. 


 


4. O controle deslizante localizado abaixo da lista Instruções para visualizar o gabarito 
ao longo do comprimento do alinhamento. 
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Na estação 9+00,00, a transição em direção à superelevação máxima para a 
primeira curva inicia. A superelevação máxima é atingida na estação 12+00,00. 


 


Na estação 21+00,00, o gabarito retorna à lomba normal. Na estação 25+60,00, a 
transição em direção à superelevação máxima para a segunda curva inicia. a 
superelevação máxima para a segunda curva é atingida na estação 34+00,00. 


 


A inclinação Final do gabarito foi superelevada com sucesso. A seguir, você aplicará 
superelevação à camada Revestimento. 
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5. Para inserir uma instrução de superelevação para a camada Revestimento, faça o 
seguinte: 


a. Na lista Instruções, clique duas vezes na última instrução na lista (a instrução 
que define o nó 10[SG-ES]). 


b. Clique no ícone Adicionar instrução  localizado na parte superior do painel 
Editar gabarito do corredor. 


c. Na lista suspensa Tipo de instrução, selecione Superelevação. 


d. Na lista Nó da lomba, selecione 8[SG-CL]. 


e. Na lista Nó do pivô, selecione 8[SG-CL]. 


Esse nó é automaticamente adicionado à lista Nós selecionados. 


f. Na lista suspensa Nó selecionado, selecione 9[SG-ES] e clique no botão 
Adicionar para adicioná-lo à lista de nós Selecionados. 


g. Na lista Selecionar nó, selecione 10[SG-ES] e clique no botão Adicionar. 


h. Na lista Nós selecionados, clique com o botão direito em 1[Superestrada] e 
selecione Excluir para removê-lo da lista. 


 


i. Na parte inferior do painel Editar gabarito do corredor, clique no botão 
Adicionar. 
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A nova instrução de Superelevação é inserida na lista Instruções. 


 


6. O controle deslizante localizado abaixo da lista Instruções para visualizar o gabarito 
ao longo do comprimento do alinhamento. 


Observe que o declive superelevado da camada Revestimento agora corresponde 
àquele da camada Encerrar. 


 
Agora você está pronto para definir os parâmetros de deslocamento para a estrada para 
garantir que as diferenças de declive entre as pistas de rodagem e acostamentos em 
curvas superelevadas sejam mantidas a um mínimo por questões de segurança e 
conforto à velocidade do projeto. Para mais informações sobre os parâmetros de 
deslocamento, consulte "Exemplos de parâmetros de deslocamento" na ajuda online. 
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Etapa 4. Definir parâmetros de deslocamento 
Como mostrado na figura a seguir, quando a estrada está à superelevação máxima na 
primeira curva, há uma diferença de 10% de declive entre a pista esquerda (a pista 
externa na curva) e o acostamento esquerdo. Há uma diferença de 2% entre a pista 
direita (a pista interna na curva) e o acostamento direito. 


 


Legenda: 
1. -4% acostamento 
2. 10% delta 
3. 6% superpista esquerda 
4. -6% superpista direita 
5. 2% delta 
6. -4% acostamento 


Ambas as diferenças de declive são muito extremas para a velocidade do projeto. Assim, 
você especificará um delta máximo e mínimo que se aplica ao corredor que alterará 
essas diferenças de declive. Você começará definindo as diferenças máxima e mínima 
de declive permitidas para a pista de rodagem direita e acostamento. 


1. Na lista Instruções, clique duas vezes na instrução que define o nó 4[ES]. Ou clique 
com o botão direito na instrução e selecione Editar. 
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Esse nó define o acostamento direito. As propriedades para a instrução são exibidas 
no modo de edição. 


 


2. Clique na caixa de seleção Definir parâmetros de deslocamento. 


 


O valor de Delta máximo especifica a diferença máxima de declive permitida entre a 
pista de rodagem e o acostamento na parte externa de uma curva. O valor de Delta 
mínimo especifica a diferença mínima de declive entre a pista de rodagem e o 
acostamento na parte interna da curva. Observe que para esta estrada a pista direita 
é a pista interna na primeira curva e a pista externa na segunda curva. O valor de 
Delta máximo será aplicado à pista direita e acostamento na segunda curva. O valor 
Delta mínimo será aplicado à pista direita e acostamento na primeira curva. 


3. No campo Delta máximo, insira 4%. No campo Delta mínimo, insira 0%. Então 
clique no botão Salvar. 


4. O controle deslizante localizado abaixo da lista Instruções para visualizar o gabarito 
ao longo do comprimento do alinhamento. 
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Observe que quando você alcançar a superelevação máxima para a primeira curva, 
a diferença entre a pista direita (interna) e o acostamento direito será agora de 0%, 
com base no 0% de Delta mínimo especificado. 


 


Quando você alcançar a superelevação máxima para a segunda curva, a diferença 
entre a pista direita (externa) e o acostamento direito será agora de 4%, com base 
nos 4% de Delta máximo especificados. 


 


Agora você está pronto para definir os parâmetros de deslocamento para a pista 
esquerda e o acostamento. Para esta estrada, a pista esquerda é a pista externa na 
primeira curva e a pista interna na segunda curva. 


5. Na lista Instruções, clique duas vezes na instrução que define o nó 6[ES]. Ou clique 
com o botão direito na instrução e selecione Editar. 


 
6. Clique na caixa de seleção Definir parâmetros de deslocamento. 


7. No campo Delta máximo, insira 4%. No campo Delta mínimo, insira 0%. Então 
clique no botão Salvar. 


8. O controle deslizante localizado abaixo da lista Instruções para visualizar o gabarito 
ao longo do comprimento do alinhamento para ver os parâmetros de deslocamento. 


 


Etapa 5. Visualizar o alinhamento na Visualização da 
Trajetória 3D 


Para ver a simulação de uma trajetória ao longo da rodovia recém superelevada, siga 
estas etapas: 
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1. Na janela Trimble Business Center, selecione Visualizar > Alinhamento > 
Visualização da Nova Trajetória 3D. 


 


2. Use o controle deslizante localizado ao longo da guia para visualizar a rodovia ao 
longo do comprimento do alinhamento. 


 


Você conclui o trabalho com superelevações e agora pode fechar o projeto. 


3. Selecione Arquivo > Fechar projeto. 
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A caixa de diálogo Salvar alterações é exibida. Se você salvou o projeto em um 
novo local ou com um novo nome, pode clicar em Sim. Caso contrário, clique em 
Não. 
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About this tutorial 
In this tutorial, you will import a survey project that includes scanned data and photo 
images captured with a Trimble VX Spatial Station while surveying a material pile. Then 
you will create a surface and calculate the volume of the pile. 


Notes: 


 To add surface boundaries as described later in this tutorial, you must be running 
Trimble Business Center software with the Survey Advanced product license. To 
verify the product license for your installation, select Help > About Trimble 
Business Center and click the License button. Licensed features are displayed in 
the Features list. 


 If you need additional help at any time you are using the software, press F1 to display 
the online help. 


 


Step 1. Open the project 
For this tutorial, you will use the project file Working with Scanned Data.vce. This file 
contains a surface that you will view later in the tutorial. Otherwise, no other data has 
been imported into the project. 


1. On the Trimble Business Center menu bar, select File > Open Project. Or, click 
the Open Project icon  on the toolbar. 


2. In the Open File dialog, browse to C:\Trimble Tutorials\TBC\Projects\Working 
with Scanned Data.vce and click Open. 


If you installed the tutorial to a location other than the default location shown here, 
browse to that location. 


The project opens in the Trimble Business Center window. 


Note: This tutorial shows the Plan View with a black background. Your background 
may be white. If you want to change it to black, select Tools > Options and select 
Background color: Black in the Options dialog. 


The project file is read-only. You can perform the tutorial steps without saving the project 
file. However, if you are interrupted while performing the tutorial, you can save it by 
selecting File > Save Project As and saving it to ..\My Documents\Trimble Business 
Center, which is the typical location for storing project files on your computer. Then, you 
can re-open the project to continue the tutorial at a later time. 


You are now ready to import survey data into your project. 


Step 2. Import survey data 
In this step, you will import a JXL (.jxl) file into your project. During the import process, 
the following related files are imported along with the JXL file: 
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 Four Trimble Scan Files (TSF) containing the scanned information from the Trimble 
VX Spatial Station 


 Numerous photo images captured with the Trimble VX during the survey 


 A Feature Definition (.fxl) file containing definitions used to record and process 
feature codes 


1. Select File > Import. Or, click the Import icon  on the toolbar. 


The Import pane opens in the right side of the Trimble Business Center window. 


2. In the Import pane, click the Browse button . 


3. Browse to C:\Trimble Tutorials\TBC\Data\Working with Scanned Data and click 
OK. 


The Working with Scanned Data folder contains the JXL job file and related files, all 
of which display in the Select File(s) list in the Import pane. 


 


4. In the Select File(s) list, select argpile144.jxl and click the Import button. 


The content of the Working with Scanned Data folder is imported into your project. 
Survey data is displayed in the Plan View. 


5. Click in the Plan View and use your mouse wheel to zoom in. Press the mouse 
wheel and move the mouse to center the points as shown here. 
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Photo images (reference images) taken during the job using the Trimble VX are 
represented by the orange lines in the Plan View. (If you zoom in, you will see these 
are actually wireframes that are used as placeholders for the images.) Scanned data 
displays as "point clouds." 


 


 


Step 3. View referenced photo images 
The imported job includes numerous referenced photo images that can be viewed on the 
Image View tab. Note that the images are located at a default pseudo-distance from the 
instrument. This is because the images themselves do not have distance information. 


You will start by verifying the default image view distance defined for your project. 


1. Select Project > Project Settings. Or, click the Project Settings icon  on the 
toolbar. 
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2. In the navigation (left) pane in the Project Settings dialog, select View > Image 
View. 


 


In some instances, modifying this distance can help to correct the alignment of 
objects between multiple images. When the objects in the images are at a distance 
greater than or less than this default distance, changing the Image View distance to 
a more realistic distance will help with the object alignment. 


However, for this tutorial you will not change the default distance. 


3. Click Cancel to close the Project Settings dialog. 


Next you will change the highlight color to make highlighted lines and point labels 
more visible in the various graphic views.  


4. To change the highlight color, do the following: 


a. Select Tools > Options. 


b. In the Options dialog, click the Browse button  for Highlight color. 


c. In the Color dialog, select bright yellow and click OK. 


 


d. In the Options dialog, click OK. 


Note: Settings in the Options dialog are not specific to a single project. They are 
kept until you change them, regardless of the project you open. If you do not want to 
keep yellow as your highlight color for other projects, you can change it at any time. 


The Options dialog includes a Cloud point size control that allows you to specify 
the pixel size of each point contained in a point cloud displayed in a graphic view. For 
this tutorial, you will leave it at the default size of 2 pixels. 
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You can click the Advanced button to display the Advanced Graphics Options 
dialog. This dialog provides options for enhancing your graphics display and 
performance when you are exploring rich data sets in the various graphic views. For 
more information on this dialog, open it and press F1. 


You are now ready to view photo images. You will start by selecting a station from 
which photos were taken. 


5. In the Plan View, do the following: 


a. Click point 102 and select Station: 102 in the context menu. 


Each station from which photos were taken is identified by a pink camera symbol 
in the Plan View. 


 


b. Right-click in the Plan View and select New Image View. 


The Image View displays showing the array of photo images taken from Station 102 
interlaced in a panoramic view.  


Notes: Depending on your computer configuration and available memory, it may take 
several moments to display the image. 
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The orange wireframes displayed on the Image View represent photo image arrays 
taken from other station setups. 


To view an array of photo images taken from a different station, you can either select 
a station (represented by a pink camera icon) or select one of the wireframes in the 
Image View. . 


6. Click one of the wireframes in the array on the right side of the photo images from 
station 102, and select Referenced Image: IMG00010.JPG in the context menu. Then 
right-click and select New Image View in the context menu. 


 


The newly selected photo image, along with other photo images in the array, displays 
centered on the Image View, outlined by a yellow box.  
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Note that the name of the station from which the array of photo images was taken is 
displayed in the lower left corner of the Image View. 


 


Note: Viewing a large number of images can require a lot of computer memory. If 
there is inadequate memory available to display all of the images, some images will 
display only as a green wireframe on the Image View. In this case, you should close 
and reopen the Image View. 


Next you will try a different method of selecting an image to view. 


7. Click on the Image View somewhere other than on an image or wireframe so that no 
image is selected. Then select View > New Image View in the menu bar. 


The Select Image dialog displays allowing you to select any station or image in the 
project to view the image(s) on the Image View tab.  


 


8. Click Cancel to close the Select Image dialog. 


Next, you will use the View Filter Manager to change how your data is displayed. 
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Step 4. Filter the view 
1. Select View > View Filter Manager. 


 


2. Deselect the following options in the Raw Data list to see how it affects your image. 


 Referenced Frame 


 Scan Point 


 Total Station 


 


Only surveyed points are displayed. 
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3. On the Point tab in the bottom of the View Filter Manager pane, deselect the Show 
point label option. 


The surveyed points circled in the following figure are on the backside and the top of 
the material pile. Because the images do not have depth, all surveyed points in the 
project are visible in the Image View. 


 


4. Reselect the Scan Point option in the Raw Data list in the View Filter Manager 
pane. Then try viewing the data using other views: 


 Select the Plan View and use your mouse wheel to zoom out as shown here. 


 


 Select View > New 3D View and experiment with changing the perspective. 


 Use the mouse wheel to zoom in or out. 


 Press the Ctrl key and use the mouse wheel to rotate the view around the X 
axis. 


 Press the Shift key and use the mouse wheel to rotate the view around the Z 
axis.  
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 Press the Ctrl + Shift key and use the mouse wheel to exaggerate 
differences between elevations. 


 Press the Ctrl key and use the mouse wheel along with moving the mouse to 
rotate the view freely in any direction. 


 


5. Reselect the Show point labels option on the Point tab in the View Filter Manager 
pane. 


In the next two steps, you will create a surface so that you can calculate the volume of 
the materials pile. 


Step 5. Create a boundary for a surface 
The scanned points around the perimeter of the materials pile are coded with appropriate 
feature codes to create four separate feature linestrings. In this step, you will first process 
the feature codes to create the linestrings. Then you will join the four linestrings into a 
single linestring to create a boundary for the material pile. Later in the tutorial, you will 
create a surface based on this boundary, and calculate the volume of the material pile. 


For this project, the feature definitions required to process the feature codes were 
imported automatically when you imported argpile144.jxl. If they had not been, you would 
need to import a Feature Definition (.fxl) file prior to processing. 


Note: For more information on working with feature codes, see the tutorial Processing 
Feature Codes. 
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1. To make it easier to see the feature linestring you are going to create, in the View 
Filter Manager, deselect the Scan Point option in the Raw Data list. Then select the 
Plan View tab. 


 


2. Process the feature codes as follows: 


a. Select Survey > Process Feature Codes. Or, click the Process Feature Codes 
icon  on the toolbar. 


b. In the Process Feature Codes pane, select the checkbox for argpile144.jxl and 
click the Process Source(s) button. 


After processing is complete, the Feature Codes Processing dialog displays asking 
if you want to view the Feature Code Processing Report. Click No. 
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A single line appears to connect all of the points around the perimeter of the material 
pile in the Plan View. 
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Actually, based on the feature codes assigned to the surveyed points, four feature 
linestrings were created: a longer linestring on each side of the pile in the Plan View, 
and a shorter linestring at the top and the bottom. In the following image, the two 
longer linestrings are selected (yellow). the two shorter linestrings are not selected 
(green) and are circled in red. 


 


3. To combine the four separate linestrings into a single linestring for the surface 
boundary, do the following: 


a. Select Lines > Join Lines in the menu bar. 


The Join Lines pane displays. 


 


b. Select the All selected lines option. 
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c. Click in the Lines to join field. 


d. While holding the Shift key, click each of the four linestrings in the Plan View. 


Each linestring turns yellow (highlighted) as you select it. 


e. In the Join Lines pane, click the Join button. 


The four separate linestrings are merged into a single linestring. 


4. In the View Filter Manager pane, select the Scan Point option in the Raw Data list. 


 


You are now ready to create a surface based on the new linestring boundary. 


Step 6. Create a surface 
1. Select Surface > Create Surface. 


The Create Surface pane displays. 
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2. In the Name field, enter MaterialPile. 


3. In the Surface classification drop-down list, select Stockpile. 


4. Click in the Members to form surface field. Then, in Plan View, draw a box around 
the newly created green Boundary line. 


 


5. Click OK. 
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The new MaterialPile surface is displayed in the Plan View. 


 


6. Select Surface > Add/Remove Surface Boundaries. 


The Add/Remove Surface Boundaries pane displays. 
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7. Click in the Boundaries to add or remove field. Then, in the Plan View, select the 
line created around the stockpile (Linestring: ToeDitch). 


 


8. In the Add/Remove Surface Boundaries pane, click the Add button. 


The surface is trimmed to the boundary.  


 


9. In the Add/Remove Surface Boundaries pane, click the Close button. 


10. Select the 3D View tab and view the edge of the material pile as shown in the 
following figure. 


 Use the mouse wheel to zoom in.  


 Press the Ctrl key and use the mouse wheel to rotate the view on the X axis.  


 Press the Shift key and use the mouse wheel to rotate the view on the Z axis. 
(Optionally, press the Alt key and click a location in the view  to select a new 
rotation point.)  


 Select View > 3D View Settings to display a pane that allows you to perform 
these same actions using interface controls. 







 Step 7. Remove unwanted scan points from the surface  


Trimble Business Center Tutorial – Working with Trimble VX Scanned Data 20 


Note: Your view does not have to match this one, as long as you can see the 
irregular points along the surface boundary as shown here. 


 


You can see variations in the surface around the perimeter of the surface (circled in 
green below). Most of these are the result of scan points being created based on 
measurements for weeds growing at the base of the pile. 


 


To ensure that your volume calculation is correct, you will need to remove these points 
since they do not represent the surface of the pile itself. 


Step 7. Remove unwanted scan points from the 
surface 


1. Click the MaterialPile surface on the 3D View to select it. Then right-click and select 
Add/Remove Surface Members. 
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The Add/Remove Surface Members pane displays. 


 


2. In the 3D View, draw a box around some of the points you want to remove from the 
surface. 


The number of selected points is displayed in the Members to add or remove field. 


 


3. Click the Remove button to remove the selected points. 
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The change is reflected in the 3D View. 


 


Typically you would repeat this procedure until you had removed all of the unwanted 
points. But for this tutorial, you are going to switch to a surface that was included in 
the project for which all unwanted points have already been reviewed. 


4. In the Add/Remove Surface Members pane, click Close. 


5. In the View Filter Manager, deselect MaterialPile in the Surface section of the list, 
and select MaterialPileDone. 
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The MaterialPileDone surface displays in the 3D View. Note that the surface no 
longer includes the unwanted points. 


 


You are now ready to calculate the volume of the material pile. 


Step 8. Calculate the volume of the material pile 
1. Select Reports > Earthwork Report. 


The Earthwork Report pane displays. 


 


2. Select the Stockpile/Depression option. 


3. In the Surface drop-down list, select MaterialPileDone. 


4. Click in the Boundary box, then select the Linestring: ToeDitch in the 3D View. 
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If necessary, zoom in to better see the linestring. 


 


5. In the Volume Breakdown section of the Earthwork Report pane, select the 
Volume totals only option. 


6. Click OK. 


The Earthwork Report opens in a browser window showing the volume calculation in 
the "Stockpile Volume Analysis" section. 


You are done calculating the volume of the materials pile. 


7. In the Trimble Business Center window, select File > Close Project. 


The Save Changes dialog displays. If you saved the project to a new location or with 
a new name, you can click Yes. Otherwise, click No. 


The next section explains how to use the Create Surface Edge Breakline command. 
Because the Working with Scanned Data.vce project file used for this tutorial does not 
include appropriate data to demonstrate this command, the section is explanatory only 
and does not include hands-on procedural instructions. 
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Note on using the Create Surface Edge Breakline 
command 


The Create Surface command sometimes adds triangle on the boundary where they are 
not needed, as shown here: 


 


Using the Trim Surface Edge command, you can remove these triangles. 
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However, subsequent editing of the surface can cause the triangles to be recalculated. 
To prevent the triangles from being recalculated, after trimming a surface you can use the 
Create Surface Edge Breakline command to draw a breakline around the existing 
surface parameter. 
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About this tutorial 
In this tutorial, you will process and edit feature codes that have been imported into your 
project. Then you will view feature data in the various project views, and export the 
features as a CAD drawing. 


Note: If you need additional help at any time you are using the software, press F1 to 
display the online help. 


Understanding Feature Code Processing 
When a surveyor observes a feature in the field, he can make a record of it that includes 
the type of feature (for example, a tree), along with its location and any associated 
attributes (for example, the height of the tree and a photo). He does this by selecting from 
a library of predefined feature codes imported from a Feature Definition (.fxl) file, and 
supplying attribute values as required. The feature codes, along with any associated 
photos and attribute values, can then be imported into a Trimble Business Center project 
and processed using the same feature definitions.  


After feature codes have been processed, the software can display symbols and line 
work that represent the real world objects. Features can then be exported to other 
systems (for example, CAD or GIS) as necessary. 


There are two basic types of features: 


 Point feature - A point feature is used to identify a single feature, such as tree or 
utility pole. Each point feature is assigned to a point, which specifies its location. After 
a point feature code is processed in Trimble Business Center, the resulting feature is 
typically represented by a specific symbol displayed on top of the point in the various 
graphic views. You can view and edit attribute values assigned to a point feature by 
opening the Properties pane for the point to which it is assigned. 


 Line feature - A line feature is used to identify a line, such as a fence or curb. When 
points with line feature codes are processed in Trimble Business Center, a linestring 
with feature data is created. The feature linestring can be easily edited using the Edit 
Linestring command. If offset lines are specified for the line feature, additional 
linestrings are created. The line style used for the linestring is determined by the 
feature definition used to define the line feature. You can view and edit attribute 
values assigned to a linestring feature by opening the Properties pane for the 
linestring. 


If a point or line feature includes a photo or other media file attribute, a Media Folder 
icon  is displayed with the point or linestring. You can view a media file by opening the 
appropriate Media Folder. 
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Step 1. Open the project 
For this tutorial, you will use the project file Processing Feature Codes.vce. The project 
includes data from a Cadastral survey of a city bus terminal. Integrated surveying 
methods were used to collect the field data.  


1. On the Trimble Business Center menu bar, select File > Open Project. Or, click 
the Open Project icon  on the toolbar. 


2. In the Open File dialog, browse to C:\Trimble Tutorials\TBC\Projects\Processing 
Feature Codes.vce and click Open. 


If you installed the tutorial to a location other than the default location shown here, 
browse to that location. 


The project opens in the Trimble Business Center window. 


 


Note: This figure shows the Plan View with a white background. Your background 
may be black. If you want to change it to white, select Tools > Options and select 
Background color: White in the Options dialog. 
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The project file is read-only. You can perform the tutorial steps without saving the project 
file. However, if you are interrupted while performing the tutorial, you can save it by 
selecting File > Save Project As and saving it to ..\My Documents\Trimble Business 
Center, which is the typical location for storing project files on your computer. Then, you 
can re-open the project to continue the tutorial at a later time. 


Step 2. Import the Feature Definition (.fxl) file 
Before you can process the feature codes imported into your project, you must import the 
same Feature Definition (.fxl) file that was used to assign codes in the field. There are 
three ways of doing this: 


 Use the Feature Code Processing section of the Project Settings dialog to import 
the Feature Definition (.fxl) file.  


 Use the Import pane to import the Feature Definition (.fxl) file. After import, the 
imported file is displayed in the Feature Code Processing section of the Project 
Settings dialog. 


 When you import a Job (.job) or JobXML (.jxl) file that specifies a Feature Definition 
(.fxl) file that is included in the same folder, the Feature Definition (.fxl) file is 
automatically imported into your project as well. After import, the imported file is 
displayed in the Feature Code Processing section of the Project Settings dialog. 


In this step, you will import the Feature Definition (.fxl) file created for this tutorial using 
the Project Settings dialog. 


1. Select Project > Project Settings. 


2. In the navigation (left) pane in the Project Settings dialog, select Feature Code 
Processing. 


 


3. Click the Browse button  located to the right of the Feature definition file field. 


4. In the Open  dialog, browse to C:\Trimble 
Tutorials\TBC\Data\GlobalFeaturesTutorial.fxl  and click Open. 


5. In the Project Settings dialog, click OK to close the Project Settings dialog.  


The feature definitions contained in GlobalFeaturesTutorial.fxl are imported into your 
project's Feature Definition Library to be used for feature processing. 
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However, before processing, you will take a look at the unprocessed feature codes in 
your project. 


Step 3. View unprocessed feature codes 
Before you process the feature codes in your project, you can view the codes and their 
assigned values, and make changes if necessary. 


1. Select View > Project Explorer. Or, click the Project Explorer icon  on the 
toolbar. 


The Project Explorer pane displays. 


2. In the Project Explorer pane, click the plus symbol next to the Points node. Then 
double-click point 700. 


 


The Properties pane displays on the right side of the window showing properties for 
point 700. The feature code assigned to the point displays in the Point Information 
section. 
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3. Click  in the Feature code field to view more information about the feature code in 
the Feature Code Editor dialog. 


 
This dialog allows you to remove a feature code, select a different feature code, add 
a feature code, and/or change attribute values. Note that the feature codes are 
defined in the GlobalFeaturesTutorial.fxl file.  


4. To view the photo assigned to point 700, select the photo attribute row and click the 
View File icon . 


The photo displays in your default photo viewing software. 
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5. When you are done viewing the Feature Code Editor, click Cancel to close the 
dialog. 


You are now ready to process the feature codes in your project. 


Step 4. Process feature codes 
You must process features codes to display their associated features correctly in graphic 
views and to export feature data. 


1. Select Survey > Process Feature Codes. Or, click the Process Feature Codes 
icon  on the toolbar. 


2. In the Process Feature Codes pane, select the checkbox for rtd topo.jxl and click 
the Process Source(s) button. 


 


After processing is complete, the Feature Codes Processing dialog displays asking 
if you want to view the Feature Code Processing Report. 


3. In the Feature Codes Processing dialog, click Yes. 


The Feature Code Processing Report displays on a new tab in the Trimble 
Business Center window. 


4. Scroll to the "Unknown Feature Codes" section. 


Note that there are four points whose feature codes are unknown. This means that 
there is no corresponding feature code contained in the project's Feature Definition 
Library to process the codes. In this case, the codes were incorrectly entered in the 
field.  


Next, you will fix the unknown feature codes before reprocessing. 


Step 5. Change feature codes 
In this procedure, you will assign the correct feature code to each of the four points listed 
in the "Unknown Feature Codes" section of the Feature Code Processing Report. But, 
because codes are read-only after features have been processed in your project, you 
must remove the processing results before you can make changes to the codes.  


1. To remove feature processing results: 


a. Select Survey > Process Feature Codes. Or, click the Process Feature Codes 
icon  on the toolbar. 
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b. In the Process Feature Codes pane, select the checkbox for rtd topo.jxl, and 
click the Remove Processing button. 


 


2. In the "Unknown Feature Codes" section of the Feature Code Processing Report, 
click point 727. 


The properties for point 727 are displayed in the Properties pane. 


 


The yellow icon  at the right in the Feature code field indicates the point has an 
unknown feature code. You can enter a new code directly in the field if you know it 
and you do not need to specify any attributes. Otherwise, you can click the  button 
to open the Feature Code Editor dialog to make the changes. For this tutorial, you 
will use both methods. 


3. Click the  button in the Feature code field. 
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The Feature Code Editor dialog displays. 


 


4. In the Feature code field, select rd and press the Delete key to remove the code. 


5. In the GlobalFeaturesTutorial.fxl list, select RB (RoadBarrier) and click the Add 
Code button. 


The code is added to the Feature code field. 


 


6. Click OK. 


The newly assigned code displays in the Feature code field in the Properties pane 
for point 727. 


 


7. Change codes for the other points displayed in the "Unknown Feature Codes" section 
of the Feature Code Processing Report. Just click each point in the report to display 
its properties in the Properties pane. 
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a. For point 728, change rd end to RB END. 


For this change, click the  button to open the Feature Code Editor dialog. 
Delete rd end from the Feature code field. Then select RB (RoadBarrier) in the 
GlobalFeaturesTutorial.fxl list and click the Add Code button. The code RB 
represents a line feature and should include the END (EndLine) line control code. 
Click the Category filter icon  and select Line Control Code to display only 
line control codes in the list. 


 


Select END in the list, and click the Add Code button.  


 


Then click OK to see the change in the Properties pane for point 728. 


 


b. For point 780, change cb 1x2m to CBI 1x2m. 


For this edit, type the change directly in the Feature code field. Note that the 
italicized text 1x2m is simply a free-form description for the code preceding it. 


 


c. For point 781, change cb inv to CBI INV. 
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Again, type the change directly in the Feature code field. 


 


You are now ready to reprocess the feature codes with the changes you made. 


Step 6. Reprocess feature codes 
1. Select Survey > Process Feature Codes. Or, click the Process Feature Codes 


icon  on the toolbar. 


2. In the Process Feature Codes pane, select the checkbox for rtd topo.jxl and click 
the Process Source(s) button. 


After processing is complete, the Feature Codes Processing dialog displays asking 
if you want to view the Feature Code Processing Report. 


3. In the Feature Codes Processing dialog, click Yes. 


A new Feature Code Processing Report displays on a new tab in the Trimble 
Business Center window. Note that there are no longer any unknown feature codes 
listed in the report. 


You can now view the processed features. 
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Step 7. View processed features 
1. Select the Plan View tab and use your mouse wheel to zoom in to view the 


processed feature data, as shown below.  


 


To better view the features, you can choose to hide unnecessary data in the Plan 
View. 


2. Select View > View Filter Manager. 


The View Filter Manger pane displays. 


 


3. In the Raw Data list: 


 Deselect RTK Vector. 


 Deselect Total Station. 
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Point feature symbols and feature linestrings are more clearly visible in the Plan 
View. 


 


To view information about a feature, including any attribute values, you can select the 
point or linestring to which the feature is assigned.  


4. In the Plan View, click the red symbol on point 700 and select Point: 700 in the 
context menu. 


The Properties pane for point 700 displays. In the lower portion of the pane, the 
Feature section displays the processed feature name and attribute values assigned 
to the point feature. 


 


You can select a different feature or change any attribute values using these fields. If 
you select a different feature for the point and then reprocess the feature codes in 
your project, the new feature you assigned to the point is kept with the point, while 
the original feature code is used to create a "secondary" feature for the point, which 
you can select in the Plan View. 


Although you can select a different feature for a point, you cannot edit the point's 
feature code after you have processed feature codes in your project. If you needed to 
change the code, you would first have to remove the feature processing results as 
described earlier in this tutorial. 
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If a feature includes a media attribute, such as a photo, a Media Folder icon  is 
displayed next to the point, as shown here.  


 


Note: A Media Folder is attached to any point or line to which a media file is 
assigned, whether it was assigned to the point as a feature attribute or assigned 
some other way. If a media file (for example, a photo) is assigned to a point as a 
feature attribute and additional media files are assigned to the point as well, you can 
select to use one of the other media files as the feature attribute by selecting it in the 
media (for example, Photo) drop-down list in the Feature section of the Properties 
pane. 


5. In the Plan View, click the Media Folder icon for point 700 and, if necessary, select 
Media Folder: 700 in the context menu. 


The Properties pane for the Media Folder is displayed showing the media file 
assigned to the point and information associated with it. You can click the View 
button  located to the right of the media file path to view the image in your default 
photo viewing software. 


6. In the Plan View, click the line running through point 700 and, if necessary, select 
Linestring: GutterLeft in the context menu. 


This is a linestring created from line feature codes during processing. The Properties 
pane for the linestring displays showing the feature name and any feature attributes.  


You can also view the features in your project in 3D. But before you do, you will apply 
additional filters to your view to make the features easier to see. 


7. In the View Filter Manger pane: 


 In the Raw Data list, deselect Media Folder. 


 In the Layers list, deselect Points.  


 On the Point tab, deselect Show point labels. 
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 On the Point tab, select Show feature symbol only. 


 


8. Select View > New 3D View. Or, click the New 3D View icon  on the toolbar. Then 
use your mouse wheel to zoom in as shown here. 


 


9. Select View > 3D View Settings. 


The 3D View Settings pane displays. You can use the controls in this pane to 
change the 3D view of the features. 


a. In the Vertical angle field, enter 54°00'00". 
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b. In the Azimuth field, enter 25°00'00". 


 
Note that by setting the Vertical Exaggeration factor to approximately 5 (experiment 
by sliding the control right and left), you can spot the elevation bust on a curb. 


 


10. To view the feature data in Google Earth, do the following: 


a. Select View > Google Earth. 


b. In the Google Earth pane, click the Options button and select Select All. 


 


c. Click the Apply button. 
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Points, feature lines, and camera icons are displayed in Google Earth. You can click 
any camera icon to display the associated image. 


 


Next, you will export the processed feature data as a CAD drawing file. 


Step 8. Export as a CAD drawing 


1. Select File > Export. Or, click the Export icon  in the toolbar. 


2. In the Export pane, select the CAD tab. 


 


3. On the CAD tab, select DWG exporter in the list at the top of the tab. 


4. In the Data section, click the Options button and select Select All. 


5. Click the Export button to create the CAD drawing (.dwg) file and save it to your 
project folder. 
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You are done working with feature codes. 


6. Select File > Close Project. 


The Save Changes dialog displays. If you saved the project to a new location or with 
a new name, you can click Yes. Otherwise, click No. 
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What's new in this release 
This release of the Trimble Business Center Tutorials includes the following updates, 
which correspond to feature updates in Trimble Business Center version 2.50: 


 The Working with Scanned Data tutorial has been updated to cover newly 
enhanced image management and viewing capabilities. It also explains how to create 
a surface border using line features. (English only.) 


 The Processing Feature Codes tutorial has been rewritten to cover major 
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Sobre este tutorial 
Neste tutorial, você ajustará a rede para um projeto que contenha dados do GNSS, da 
estação total e de nível. 


Observações:  


 Para realizar um ajuste de rede em dados do GNSS, da estação total e de nível 
combinados, você deve estar executando o software Trimble Business Center com 
a licença de produto Survey Advanced. Para verificar a licença do produto para sua 
instalação, selecione Help > About Trimble Business Center e clique no botão 
Licença. Os recursos licenciados são exibidos na lista Recursos. 


 Se você precisar de ajuda adicional em qualquer momento em que estiver usando o 
software, pressione F1 para exibir para a ajuda online. 


 


Etapa 1. Abra um projeto 
Para esse tutorial, você usará o arquivo de projeto Adjusting the Network.vce. Os dados 
do GNSS, da estação total e de nível já foram importados para o projeto, e as linhas de 
base do GNSS foram processadas. 


1. Na barra de menu do Trimble Business Center, selecione Arquivo > Abrir 
projeto. Ou clique no ícone Abrir projeto  na barra de ferramentas. 


2. Na caixa de diálogo Abrir arquivo, navegue para C:\Trimble 
Tutorials\TBC\Projects\Adjusting the Network.vce e clique em Abrir. 


Se você instalou o tutorial em um local que não o padrão mostrado aqui, navegue 
para esse local. 
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O projeto abre na janela Trimble Business Center. 


 


Observação: Esta figura mostra a guia Visualização de plano com um plano de 
fundo branco. Seu plano de fundo pode ser preto. Se desejar alterá-lo para branco, 
selecione Ferramentas > Opções e selecione Cor do plano de fundo: Branco na 
caixa de diálogo Opções. 


O arquivo de projeto é somente leitura. Você pode realizar as etapas do tutorial sem 
salvar o arquivo do projeto. Entretanto, se você for interrompido enquanto estiver 
realizando o tutorial, pode salvá-lo selecionando Arquivo > Salvar projeto como e 
salvando em ..\Meus documentos\Trimble Business Center, que é o local típico para 
armazenar arquivos de projeto no seu computador. Então você pode reabrir o projeto 
para continuar o tutorial mais tarde. 


Antes de ajuste a rede no seu projeto, você deve realizar algumas alterações às 
configurações do projeto. 


Etapa 2. Modificar as configurações do projeto 
Nesta etapa, você selecionará as origens a serem usadas para erros padrão. Então você 
especificará os erros padrão para os dados da estação total, de nivelamento e do GNSS. 


1. Selecione Projeto > Configurações do Projeto. Ou clique no ícone Configurações 
de projeto  na barra de ferramentas. 
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2. No painel de navegação (esquerdo) na caixa de diálogo Configurações de projeto, 
selecione Ajuste de rede > Geral. Então selecione Usar média de observações na 
lista suspensa Ângulos médios. 


 


3. No painel de navegação, selecione Erros padrão. Então selecione as opções como 
segue: 


 Estação Total: 
- Origem para erros padrão: Arquivos importados 
- Origem para centralizar erros: Configurações do projeto 


 Nivelamento: 
- Origem para erros padrão: Configurações do projeto 


 GNSS: 
- Origem para erros padrão: Processador de linha de base 


 Azimute: 
- Origem para erros padrão: Configurações do projeto 


4. No painel de navegação, selecione Erros padrão > Estação total. Então selecione 
as opções como segue: 


 Erros Padrão: 
- Ângulo horizontal: 0°00'05" 
- Ângulo Vertical: 0°00'05" 


 Erros de centralização padrão: 
-Erro de centralização do instrumento: 0,002 m 
-Erro de centralização do destino: 0,002 m 


 Erros de altura padrão: 
- Erro na altura do instrumento: 0,002 m 
- Erro na altura do destino: 0,002 m 


5. No painel de navegação, selecione Erros padrão > Nivelamento. Então selecione 
as opções como segue: 


 Erros Padrão: 
- Erro padrão em 1 km de nivelamento duplo: 0,0 mm 
- Erro padrão para a configuração de cada estação: 3,0 mm 


6. No painel de navegação, selecione Erros padrão > GNSS. Então selecione as 
opções como segue: 


 Erros de configuração padrão: 
- Erro na altura da antena: 0,002 
- Erro de centralização: 0,005 
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7. Clique em OK para fechar a caixa de diálogo Configurações do projeto. 


Agora você está pronto para realizar um ajuste de rede. Você fará isso usando um 
processo de duas etapas. Primeiro, realizará um ajuste de rede minimamente restrito. 
Então você realizará um ajuste de rede restrita. 


Etapa 3. Realizar um ajuste de rede minimamente 
restrito 


Para avaliar a consistência interna da rede do levantamento, você deve primeiro realizar 
um ajuste de rede minimamente restrito, que usa o número mínimo de restrições 
necessário para definir o sistema de coordenadas. 


1. Selecione Levantamento > Ajustar Rede. 


O painel Ajustar Rede é exibido. 


 


Há 13 pontos de controle listados na guia Coordenadas fixas. Dez são os pontos 
de controle vertical dos dados de nível DiNi e da planilha de dados. 


 B412 


 barbara 


 ENERGY 


 F 408 


 flange 


 hard 


 Jeffco AZ MK 


 Jeffco Reset 


 Jeffco Reset 


 sixtwo 


Há três pontos de controle horizontais da planilha de dados CORS (Continuously 
Operating Reference Stations): 


 P041 


 PLTC 
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 TMGO 


Para este projeto, você realizar um ajuste minimamente restrito mantendo a estação 
P041 fixa em 2D e h. 


2. Na guia Coordenadas fixas, marque as caixas de seleção 2D e h para P041. 


 


3. Clique no botão Ajustar. 


É exibida uma mensagem perguntando se você deseja resolver os erros de cálculo 
do projeto. Clique no botão Sim para continuar o ajuste de rede sem resolver os 
erros. 


Um resumo dos resultados do ajuste é exibido na guia Resultados no painel 
Ajustar rede. 


 


O Fator de referência é 1,35, os Graus de liberdade são 268 e o teste do qui-
quadrado Falhou. Isso indica que alguns vetores podem ter sido sinalizados como 
tendo discrepâncias no ajuste e/ou é necessário aplicar uma estratégia de 
ponderação para os vetores processados. 


4. No painel Ajustar rede, clique no ícone Relatório . 


O Relatório de ajuste de rede é exibido em uma janela do navegador. Para navegar 
para as diversas seções do relatório, clique nos links no painel de navegação no 
lado esquerdo do relatório ou use o mouse para rolar pelo relatório. 


5. Revise o relatório, prestando atenção especial às seções de "Observações": 
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Observações com um residual padronizado que falharam nos critérios Tau são 
exibidas em vermelho. Essas observações são discrepantes. Neste caso, os vetores 
pós-processados TMGO --> PLTC (PV135) e o filtro --> 5 (PV22) são sinalizados 
como tendo discrepâncias (texto vermelho) na seção "Observações GPS ajustadas".  


 


Observação: O software automaticamente atribui um número entre parênteses a 
cada conjunto de observações. Os números no seu relatório podem variar com 
relação aos números mostrados acima. 


Uma vez que você tem uma redundância de alto nível na rede, pode desativar 
TMGO --> PLTC (PV135) e o filtro --> 5 (PV22), e depois reajustar a rede. 


6. No Relatório de ajuste de rede, clique no link TMGO --> PLTC (PV135) na seção 
"Observações GPS ajustadas". 


Isso seleciona o vetor no projeto. 


7. Na janela Trimble Business Center, clique com o botão direito na Visualização do 
plano e selecione Propriedades no menu de contexto. 


O painel Propriedades é exibido mostrando TMGO --> PLTC (PV135). 


 


Observação: Se você clicar em qualquer outro lugar na janela antes de clicar com o 
botão direito na Visualização do plano, o vetor não será mais selecionado. 
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8. Na lista suspensa Status, selecione Desativado. 


A caixa de mensagem Limpar ajuste é exibida perguntando se você deseja manter 
ou limpar os resultados do ajuste de rede realizado anteriormente.  


9. No diálogo Limpar ajuste, clique no botão Limpar ajuste. 


10. Repita as etapas de 6 a 8 para o filtro do vetor --> 5 (PV22)  


Com TMGO --> PLTC (PV135) e filtro --> 5 (PV22) desativados, é possível repetir 
agora o processo de ajuste de rede. 


11. Selecione Levantamento > Ajustar Rede. Então clique no botão Ajustar para 
repetir o ajuste de rede de minimamente restrito. 


É exibida uma mensagem perguntando se você deseja resolver os erros de cálculo 
do projeto. Clique no botão Sim para continuar o ajuste de rede sem resolver os 
erros. 


Um resumo dos resultados do ajuste é exibido na guia Resultados no painel 
Ajustar rede. 


 


12. Clique no ícone Relatório para visualizar o Relatório de ajuste de rede. 


O teste do qui-quadrado ainda falhou, então é necessário aplicar uma estratégia de 
ponderação aos vetores processados. Aplicar uma estratégia de ponderação 
melhorará as estimativas de erros a priori iniciais para as observações. Erros a priori 
são estimados para observações antes de um ajuste de rede ser realizado. 


13. No painel Ajustar rede, selecione a guia Pesagem. 


 


Na seção Vetores pós-processados, o fator de referência de rede é listado na 
caixa à esquerda como 1,04. O objetivo é atingir o fator de referência 1,00. 
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14. Nos Vetores pós-processados, seções Ângulos horizontais, Ângulos verticais, 


Distâncias de declive e Nivelamento, clique em  para aplicar um escalar aos 
erros estimados. 


O software calcula um novo escalar usando o fator de referência de rede a partir do 
último ajuste. Esse escalar é aplicado às estimativas de erro inicial para todos os 
vetores pós-processados no ajuste. 


Agora você está pronto para recalcular o ajuste minimamente restrito. 


15. Clique no botão Ajustar 


É exibida uma mensagem perguntando se você deseja resolver os erros de cálculo 
do projeto. Clique no botão Sim para continuar o ajuste de rede sem resolver os 
erros. 


A guia Resultados é exibida no painel Ajustar rede. 


 


O Fator de referência agora é 0,97 e o teste do qui-quadrado foi Aprovado. As 
estimativas de erro a priori iniciais concordam com os erros ajustados para os 
vetores de rede.  


Agora você está pronto para realizar um ajuste de rede restrito. 


Etapa 4. Realizar um ajuste de rede restrito 
Nesta etapa, você realizará um ajuste restrito no qual os pontos de controle restantes 
são mantidos (fixos) para as coordenadas das planilhas de dados importadas. O objeto é 
calcular coordenadas ajustadas para os pontos medidos na rede de levantamento com 
relação às estações de controle existentes. 


As estações neste levantamento são de qualidade de levantamento mista, incluindo: 


 Qualidade CORS (Continuously Operating Reference Stations) 


 Qualidades variáveis de estações de referência de rede nacionais 


 Qualidade de observação DiNi ajustada  


Você pode atribuir valores de erro padrão a cada ponto de controle com base na sua 
qualidade, usando os valores ajustados de levantamentos anteriores ou estimativas de 
erro das CORS ou ajustes de estação de referência de rede nacionais.  Quando você 
atribui um erro padrão a um ponto de controle, você possibilita que o ajuste de rede para 
ajustar o valor de coordenadas do ponto de controle com base na qualidade das 
observações e outros pontos de controle. 
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Se você escolher não atribuir valores de erro padrão, um valor "fixo" de 0,000001 
(micrômetro) é atribuído a cada ponto, independentemente da qualidade do ponto. 


Para este tutorial, você inserirá valores "fixos" para as estações CORS, estimativas de 
precisão de planilhas National Geodetic Survey (NGS), junto com alguns valores 
presumidos para os pontos de controle de ordem inferior. 


1. No painel Ajustar rede, selecione a guia Coordenadas fixas. Então clique no ícone 
Usar pesagem atribuída na parte superior do painel. 


A guia Coordenadas fixas é substituída pela guia Coordenadas restritas. 


 


Agora você pode expandir cada ponto de controle para inserir estimativas de erro 
padrão. Para este tutorial, você inserirá os valores de Norte e Leste das estimativas. 
(Se disponível, você pode inserir valores horizontais.) Entretanto, antes de fazer 
isso, você precisará fazer algumas alterações às suas configurações de projeto. 


2. Selecione Projeto > Configurações do Projeto e faça o seguinte:  


a. Selecione Unidades > Coordenadas e selecione Sim na lista suspensa 
Expandir erros padrão horizontais. 


 


b. Selecione Unidades > Distância e selecione 0,1234 na lista suspensa Precisão 
decimal. 


c. Clique em OK para fechar a caixa de diálogo Configurações do projeto. 


3. Na guia Coordenadas restritas no painel Ajustar rede, faça o seguinte: 


a. Clique no símbolo de mais para expandir B412. Então insira 0,0100 m no campo 
Elevação. 
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b. Clique me + para expandir barbara e inserir: 
0,0074 m no campo Norte 
0,0057 m no campo Leste 
0,0294 m no campo Altura 


 


Tipicamente, você inseriria estimativas de erro para o restante dos pontos também. 
Entretanto, para este tutorial, os valores adicionais já foram inseridos. 


Estimativas de erro inseridas para um ponto são usadas no ajuste apenas se você 
selecionar uma ou mais das caixas de seleção "fixas" para o ponto, tornando-o um 
ponto restrito. 


Embora, na prática, você normalmente assumiria uma abordagem mais incremental 
para o ajuste restrito e adicionaria apenas um ponto de controle por vez, para este 
tutorial você concluirá o ajuste restrito em duas etapas. Primeiro, restringirá as 
coordenadas geodésicas locais NAD83 para os três pontos de controle horizontais. 
Então você adicionará as restrições de elevação para a elevação de controle DiNi 
Trimble. 


Observe o seguinte: 


 Os valores locais (2D e h) referem-se a coordenadas geodésicas locais NAD83 
(latitude, longitude e altura elipsoide) importadas das planilhas de dados. 


 Valores de quadrícula (e) referem-se a elevações NAVD88 importadas da 
planilha de dados ou dos arquivos de nível digital ajustados. 


Para este tutorial, você restringirá pontos usando as coordenadas geodésicas locais. 
Você adicionará restrições de elevação mais tarde. 


4. Recolha os nós de ponto expandidos e selecione as restrições para o ajuste 
marcando as caixas de seleção 2d e h para os seguintes pontos: 


 hard 


 P041 (já deve ter sido verificado) 


 PLTC  
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 TMGO 


 


5. Clique no botão Ajustar. 


É exibida uma mensagem perguntando se você deseja resolver os erros de cálculo 
do projeto. Clique no botão Sim para continuar o ajuste de rede sem resolver os 
erros. 


A guia Resultados é exibida. 


 


Tipicamente, você revisaria o Relatório de ajuste de rede. Com base nessa revisão, 
você pode decidir selecionar algum outro ponto de controle horizontal. Para este 
tutorial, você continuará sem selecionar outros pontos de controle horizontais. 


Em seguida, você restringirá apenas as coordenadas 2D para os três pontos de 
controle horizontais. Você também adicionará elevações referenciais como 
restrições verticais. Desta forma, a rede é restringida horizontalmente para as 
coordenadas geodésicas locais NAD83 e verticalmente para as elevações 
referenciais NAVD88 como medidas pelo nível DiNi. 


6. Na guia Coordenadas restringidas, desmarque a caixa de seleção h para cada um 
dos quatro seguintes pontos locais. 


 hard 


 P041 


 PLTC 


 TMGO 


Isso removerá as restrições de altura elipsoide adicionadas anteriormente. 


7. Marque a caixa de seleção e para os pontos de quadrícula: 
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 B 412 


 F 408 


 sixtwo 


Isso adiciona a elevação referencial para o ajuste. 


8. Clique no botão Ajustar. 


É exibida uma mensagem perguntando se você deseja resolver os erros de cálculo 
do projeto. Clique no botão Sim para continuar o ajuste de rede sem resolver os 
erros. 


A guia Resultados é exibida. 


 


9. Na barra de ferramentas da janela Trimble Business Center, clique no ícone Mais 
zoom conforme o necessário para ampliar a visualização como mostrado aqui. 
Ou clique na Visualização do plano e use a roda do mouse para aproximar o zoom. 
Pressione a roda do mouse e mova o mouse para o centro dos pontos. 


 


As elipses de erro são exibidas em vermelho. 


10. No painel Ajustar rede, clique no ícone Relatório e visualize a seção 
"Coordenadas de quadrículas ajustadas". 
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Esta seção do relatório ilustra quais coordenadas foram mantidas fixas no ajuste. 
Todas as coordenadas, exceto pelos pontos de controle, têm erros estimados. 


A guia Resultados no painel Ajustar rede exibe erros e residuais para um ou mais 
pontos, observações ou vetores pós-processados selecionados. Na Visualização do 
plano, selecione os itens que deseja visualizar traçando uma caixa ao redor deles. 
Suas seleções são exibidas na guia Resultados. 


 


Você concluiu o ajuste de rede. Em seguida, você importará dados adicionais para o seu 
projeto ajustado. 


Etapa 5. Importar dados adicionais para o projeto 
ajustado 


Se os dados de trabalho adicionais que estão sendo importados incluírem os mesmos 
pontos IDs que o projeto ajustado, você pode selecionar para ter novas coordenadas 
com base nos valores de coordenada ajustados. Neste caso, você importará um novo 
arquivo de dados que inclui uma transversal do ponto 5 para o ponto frey, pontos que já 
existem no projeto ajustado. 


1. Selecione Arquivo > Importar .Ou clique no ícone Importar  na barra de 
ferramentas. 
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O painel Importar abre no lado direito da janela Trimble Business Center. 


 


2. No painel Importar, clique no botão Procurar . 


3. Na caixa de diálogo Procurar pasta, navegue para C:\Trimble 
Tutorials\TBC\Data\Adjusting the Network e clique em OK. 


4. Na lista Selecionar arquivo (s), selecione 53frey.jxl e clique no botão Importar. 


Uma vez que o software detecta uma diferença entre o sistema de coordenadas 
especificado no projeto e o sistema de coordenadas especificado no arquivo 
importado, o diálogo da mensagem Sistema de coordenadas do projeto é exibida. 


5. Selecione a opção Manter a definição de projeto existente no diálogo da 
mensagem Sistema de coordenadas do projeto. Então clique em OK. 


A caixa de diálogo da mensagem Limpar ajuste é exibida perguntando se deve ou 
não manter o ajuste de rede recém completado. Para este tutorial, você manterá o 
ajuste após importar os novos dados. 


6. Na caixa de diálogo Limpar ajuste, clique no botão Manter ajuste. 


Os novos dados são importados com base nos valores de coordenadas dos pontos 
5 e frey que foram calculados no ajuste de rede. 
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Na barra de ferramentas do Trimble Business Center, é possível clicar no ícone 
Mais zoom (ou usar a roda do mouse) conforme o necessário para ampliar a 
visualização como mostrado aqui para ver a transversal recém importada. 


 


7. Selecione Visualizar > Explorador do Projeto. Então, no painel Explorador do 
projeto, clique com o botão direito em Pontos > frey e selecione Relatório de 
derivação de ponto. 


O Relatório de derivação do ponto é exibido em uma janela do navegador. 


O relatório mostra o valor onde o ponto frey foi estabelecido. Neste caso, é o valor 
ajustado da rede. Também é possível ver o valor de coordenadas da importação do 
arquivo 53frey.jxl. 


Você concluiu o ajuste de rede. 


8. Na barra de menu do Trimble Business Center, selecione Arquivo > Fechar 
projeto. 


A caixa de diálogo Salvar alterações é exibida. Se você salvou o projeto em um 
novo local ou com um novo nome, pode clicar em Sim. Caso contrário, clique em 
Não. 
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Sobre este tutorial 
Neste tutorial, você importará dois arquivos de dados capturados comum nível DiNi 
Trimble em um projeto que já contém dados GNSS. 


Observação: Se você precisar de ajuda adicional em qualquer momento em que estiver 
usando o software, pressione F1 para exibir para a ajuda online. 


Etapa 1. Abra um projeto 
Para esse tutorial, você usará o arquivo de projeto Importing Digital Level Data.vce. Os 
dados do GNSS já foram importados para o projeto e as linhas de base do GNSS foram 
processadas. 


1. Na barra de menu do Trimble Business Center, selecione Arquivo > Abrir 
projeto. Ou clique no ícone Abrir projeto  na barra de ferramentas. 


2. Na caixa de diálogo Abrir arquivo, navegue para C:\Trimble 
Tutorials\TBC\Projects\Importing Digital Level Data.vce e clique em Abrir. 


Se você instalou o tutorial em um local que não o padrão mostrado aqui, navegue 
para esse local. 
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O projeto abre na janela Trimble Business Center. 


 


Observação: Esta figura mostra a Visualização de plano com um plano de fundo 
branco. Seu plano de fundo pode ser preto. Se desejar alterá-lo para branco, 
selecione Ferramentas > Opções e selecione Cor do plano de fundo: Branco na 
caixa de diálogo Opções. 


O arquivo de projeto é somente leitura. Você pode realizar as etapas do tutorial sem 
salvar o arquivo do projeto. Entretanto, se você for interrompido enquanto estiver 
realizando o tutorial, pode salvá-lo selecionando Arquivo > Salvar projeto como e 
salvando em ..\Meus documentos\Trimble Business Center, que é o local típico para 
armazenar arquivos de projeto no seu computador. Então você pode reabrir o projeto 
para continuar o tutorial mais tarde. 


Antes de importar dados de nível digital para seu projeto, selecione um erro padrão a ser 
usado para os dados. 


Observação: Você pode alterar o erro padrão para um projeto a qualquer momento. 
Entretanto, para aplicar as alterações, você deve abrir e fechar a caixa de diálogo Editor 
de nível como descrito mais adiante neste tutorial. 
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Etapa 2. Selecione um erro padrão a ser usado como 
padrão 


Nesta etapa, você selecionará para usar erros padrão no seu projeto, e verificará o valor 
padrão a ser usado para calcular o erro padrão aplicado a observações no Editor de 
nível. 


1. Selecione Projeto > Configurações do Projeto. Ou clique no ícone Configurações 
de projeto  na barra de ferramentas. 


2. No painel de navegação (esquerdo) na caixa de diálogo Configurações de projeto, 
selecione Erros padrão. 


3. Na seção Nivelamento, selecione Configurações do projeto na lista suspensa 
Origem para erros padrão. 


 


Isso garante que o valor de erro padrão especificado em Configurações do projeto 
(como descrito nas próximas duas etapas) seja usado para calcular o erro padrão 
aplicado a observações do Editor de nível. 


Observação: Como uma alternativa, você poderia selecionar um valor de erro 
padrão especificado no arquivo de dados e exibido em um campo editável na caixa 
de diálogo Editor de nível durante a importação. Isso seria útil se, por exemplo, 
você estivesse importando dados de nível de diversos instrumentos DiNi com 
diferentes precisões e desejasse editar o erro padrão para cada um durante a 
importação. Mas, para este tutorial, você usará o valor Configurações do projeto. 


4. No painel de navegação (esquerdo) na caixa de diálogo Configurações de projeto, 
selecione Erros padrão > Nivelamento. 


5. No campo Erro padrão em 1 km de nivelamento duplo, insira 0,7 mm. 
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Certifique-se de que o campo Erro padrão para cada configuração de estação 
contenha o valor 0,0 mm. Se os valores forem especificados em ambos os campos, 
os erros padrão nivelamento usarão a combinação desses valores para calcular os 
erros padrão para as observações. 


 


6. Clique em OK. 


Você concluiu a alteração das configurações do projeto e agora está pronto para 
importar dados de nível digital para seu projeto. 


Etapa 3. Importar o primeiro arquivo de dados de nível 
digital 


Para este tutorial, você importar dois arquivos de dados de nível digital. Para o primeiro 
arquivo de dados, que contém diversas execuções de nível, você mesclará execuções, 
renomeará e desmarcará pontos e ajustará as execuções antes de importar. Para o 
segundo conjunto de dados, que contém uma execução de nível único, você importará 
os dados sem ajustá-los. 


1. Selecione Arquivo > Importar .Ou clique no ícone Importar  na barra de 
ferramentas. 


O painel Importar abre no lado direito da janela Trimble Business Center. 


 


2. No painel Importar, clique no botão Procurar . 
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3. Na caixa de diálogo Procurar arquivo, navegue para C:\Trimble 
Tutorials\TBC\Data\Importing Digital Level Data e clique em OK. 


O conteúdo da pasta Importing Digital Level Data (Importação de dados de nível 
digital) é exibido na lista Selecionar arquivo(s) no painel Importar. 


4. Na lista Selecionar arquivo (s), selecione B412.DAT e clique no botão Importar. 


A caixa de diálogo Editor de Nível é exibida. 


 


Esse diálogo permite revisar o nível de dados que você está importando e fazer as 
alterações necessárias. A soma das distâncias BS e FS é exibida para que você 
possa verificar se o equilíbrio de distância de observação é alcançado. 


O arquivo de dados de nível importados inclui dados para seis execuções de nível 
separadas que compõem três execuções duplas. No desenho abaixo, você pode ver 
como as execuções são conectadas. 
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Sua primeira etapa é unir execuções de nível de modo que o Editor de nível possa 
calcular desajustes. 


Etapa 4. Unir execuções de nível 
No arquivo B412.dat, o ponto B412 é o único ponto que possui uma elevação de controle 
inserida (veja a figura a seguir). 


Para o Editor de nível calcular desajustes, uma execução deve começar e terminar no 
mesmo ponto, ou começar e terminar em duas elevações de ponto de controle. Essas 
execuções de nível começam ou terminam com um referencial ou começam ou 
terminam com pontos desconhecidos. Em todos esses casos, nenhum desajuste é 
calculado para as execuções. 


 


Observação: Seria aceitável importar dados de nível para o projeto sem unir execuções 
de nível ou desajustes. Todos os dados serão combinados para refletir o levantamento 
como ele foi executado. Você também pode realizar um ajuste de quadrado mínimo no 
Editor de nível sem unir as execuções. Entretanto, combinar execuções de nível 
fornece uma verificação de boa qualidade e ajuda a descobrir erros e enganos. 


Para este tutorial, você usará o Editor de nível para unir execuções de nível. Observe 
que para duas execuções de nível serem unidas, o ponto final da primeira execução 
deve ser o primeiro ponto na segunda execução. 


1. Na caixa de diálogo Editor de nível, clique no botão Unir execuções localizado no 
canto inferior direito da caixa de diálogo. 
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A caixa de diálogo Unir Execuções é exibida. 


 


2. Para unir execuções, faça o seguinte: 


a. No campo Nome da nova execução, insira 15. 


b. Na lista Iniciar com nome de execução, selecione 1, que termina com a flange 
de ponto. 


c. Na lista Adicionar este Nome de execução, selecione 5, que começa com a 
flange do ponto. 


d. Clique em OK. 


As guias Execução na caixa de diálogo Editor de nível mostram como as 
execuções 1 e 5 foram unidas em uma nova execução 15. 
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Observação: Na caixa de diálogo Editor de nível, é possível clicar no botão 
Reiniciar localizado na área inferior direita da caixa de diálogo para desfazer 
qualquer alteração feita ao arquivo durante a sessão de edição. Entretanto, quando 
fizer as alterações e clicar em OK, essas alterações são salvas, incluindo execuções 
unidas. Se você abrir a caixa de diálogo Editor de nível para esse arquivo depois de 
importar,clicar no botão Reiniciar não desfará as alterações realizadas na sessão de 
edição anterior. Se tiverem sido cometidos erros durante a edição anterior, você 
pode excluir o arquivo na área Explorador do projeto > Arquivos importados e 
depois reimportar o arquivo. 


3. Repita o procedimento de união para unir as execuções como segue:  


a. Unir as execuções 6 e 2 em uma nova execução 62. 


b. Unir as execuções 15 e 62 em uma nova execução 1562. 


c. Unir as execuções 3 e 4 em uma nova execução 34. 


Um desajuste é exibido para cada execução unida, permitindo determinar se as 
execuções atenderam às exigências. 


 


 


Etapa 5. Renomear e cancelar a seleção de pontos 
Na Execução 1562, você pode ver pontos com um ponto amarelo ao lado do ponto ID. 
Isso indica que o ponto é usado em outras execuções dentro desse arquivo. 
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O Editor de nível pesquisa no arquivo para encontrar pontos que foram renomeados 
automaticamente pelo Trimble DiNi e os pontos que receberam um nome exclusivo pelo 
agrimensor. É por isso que alguns pontos são marcados para serem criados no Trimble 
Business Center e outros não são. 


 


Se um desses pontos com nome DiNi ou um ponto que seja similar à convenção de 
nomenclatura realmente for para ser criado, é possível selecionar a caixa ao lado do 
Ponto ID para criar o ponto no projeto. 


Nesse arquivo, alguns dos pontos IDs precisam ser renomeados devido ao número de 
caracteres no ponto ID permitido pelo DiNi. Nesses casos, os pontos precisam ser 
renomeados para corresponderem aos pontos já no projeto. 


1. Selecione a guia Execução 1562 e altere os pontos ID para cada um dos seguintes 
pontos clicando no campo Ponto ID e digitando o novo nome: 


 Alterar jeffcoaz para jeffco az mk. 


Uma vez que esse ponto possui outras observações nessa execução, é exibida 
uma mensagem perguntando quanto a renomear ou não todas as observações. 
Selecione Sim. 


 Alterar jeffco r para jeffco reset. 


Uma vez que esse ponto é observado novamente apenas como a visada atrás 
para a próxima configuração, nenhuma mensagem é exibida perguntando 
quanto a renomear ou não todas as observações. 


 Alterar A412 res para A 412 reset. 


Em Execução 34, há diversos pontos selecionados para serem criados no projeto 
que precisam ser criados. Você pode cancelar a seleção, como explicado na 
próxima etapa. 


2. Selecione a guia Execução 34 e cancele a seleção dos seguintes pontos na coluna 
Criar: 


 HYD1 


 thing 


 HYD2 


 HYD3 


Agora você está pronto para ajustar execuções de nível e importar dados. 
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Etapa 6. Ajustar execuções de nível e importar os 
dados 


Observe que desajustes para a Execução 1562 e a Execução 34 foram calculados. 


 


 


Você poderia importar esses dados usando as elevações brutas e então usar o comando 
Ajustar rede no Trimble Business Center para ajustar os erros nos dados. Mas, para 
este tutorial, você usará os pontos DiNi estabelecidos como pontos de controle vertical 
para ajuste de rede, de modo que você precisa ajustar as execuções no Editor de nível. 


1. Clique no botão Ajustar execuções localizado na área inferior direita da caixa de 
diálogo. 


A caixa de diálogo Ajustar execuções é exibida. Por padrão, ambas as execuções 
são selecionadas para ajuste. 


 


2. Clique em OK.  
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Um ajuste de quadrados mínimos é realizado nos dados. A elevação ajustada e a 
correção são exibidas para cada ponto na caixa de diálogo Editor de nível. 


 


Agora você pode usar essas elevações ajustadas quando realizar um ajuste de rede 
para ajustar os outros dados no projeto. 


3. Na caixa Opções de criação na área inferior da caixa de diálogo Editor de nível, 
selecione a opção Evitar ajuste adicional. 


 


Isso fará com que cada ponto seja criado com uma elevação de qualidade de 
Controle. Apenas a elevação de qualidade de Controle será importada; a 
observação não o será. Para o ajuste de rede, esses pontos estarão na lista 
Coordenadas fixas, elegível para uso como pontos fixos. 


Se você tivesse selecionado a opção Permitir ajuste de rede, cada ponto seria 
criado com qualidade de Levantamento e as observações de elevação de delta 
acumuladas entre os pontos seriam criadas. 


4. Clique em OK para importar os dados de nível ajustados para o seu projeto. 


5. Para visualizar os dados de nível digitais recém importados para o Explorador do 
projeto.  


a. Selecione Visualizar > Explorador do Projeto. 


b. No painel Explorador do projeto, clique no símbolo de mais antes de Arquivos 
importados. 
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c. Role para baixo para B412.DAT, clique com o botão direito no nome do arquivo 
e selecione Expandir no menu de contexto. 


 


Agora você está pronto para importar o segundo arquivo de dados de nível digital 
necessário para este projeto. 


Etapa 7. Importar o segundo arquivo de dados de 
nível digital 


Para esta etapa, você importará um arquivo de dados de nível com apenas uma 
execução de nível. É um ciclo iniciando no ponto sixtwo O agrimensor presumiu uma 
elevação de 100,000 quando iniciou a execução. O ponto sixtwo foi um dos pontos de 
controle estabelecidos pelo dado de nível B412.DAT. Porque os pontos nessas 
execuções foram armazenados como pontos de controle, você pode usar essas 
elevações para estabelecer elevações nessa execução. O ponto deve ter uma elevação 
com qualidade de Controle a ser selecionada aqui. 


Na "Etapa 3. Importar o primeiro arquivo de dados de nível digital", você importou dados 
usando o comando Importar. Para esta etapa, você usará um método diferente para 
importar dados: arrastar e soltar. 


1. No Windows, selecione Iniciar > (Meu) Computador e navegue para C:\Trimble 
Tutorials\TBC\Data\Importing Digital Level Data. 


2. Na pasta Digital Level Data, clique e arraste o arquivo SIXTWO.DAT para a 
Visualização do plano na janela Trimble Business Center. 
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A caixa de diálogo Editor de Nível é exibida. 


 


3. No campo Tipo de elevação para o ponto sixtwo, selecione Coordenadas na lista 
suspensa e clique fora do campo. 


O Editor de nível lê a elevação do ponto sixtwo a partir do projeto e insere-a no 
campo Elevação Ajustada. 


 


Esse ciclo é executado através de diversos pontos no seu projeto: sixtwo, hanna e 
filter. Entretanto, há diversos outros pontos na execução que não precisam ser 
criados. 


4. Na coluna Criar, desmarque todos os pontos, exceto sixtwo, hanna e filter. 


Uma vez que essa é uma execução de nível de ciclo, o Editor de nível calculou um 
desajuste de 0,00550m. 


 


Você poderia ajustar essa execução para corrigir esse erro como fez com o arquivo 
B412.DAT. Mas, em vez disso, você importará os dados sem um ajuste. Os dados 
serão ajustados mais tarde como parte de um ajuste de rede. 


5. clique em OK para importar o segundo arquivo de dados para o seu projeto. 
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Os dados de nível digital recém importados são exibidos no Explorador do Projeto. 


 


Você concluiu a importação de dados de nível digital para o seu projeto. 


6. Selecione Arquivo > Fechar projeto. 


A caixa de diálogo Salvar alterações é exibida. Se você salvou o projeto em um 
novo local ou com um novo nome, pode clicar em Sim. Caso contrário, clique em 
Não. 
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Sobre este tutorial 
Neste tutorial, você importará dados do GNSS de estatística e controle para um novo 
projeto, unirá pontos e fará download de dados de referência e órbita precisos. Também 
importará uma imagem com referência geográfica para o projeto. 


Observação: Se você precisar de ajuda adicional em qualquer momento em que estiver 
usando o software, pressione F1 para exibir para a ajuda online. 


Etapa 1. Abra um projeto 
Para esse tutorial, você usará o arquivo de projeto Importing GNSS Data.vce. As 
configurações do projeto foram especificadas, mas nenhum dado foi importado para o 
projeto. 


1. Na barra de menu do Trimble Business Center, selecione Arquivo > Abrir 
projeto. Ou clique no ícone Abrir projeto  na barra de ferramentas. 


2. Na caixa de diálogo Abrir arquivo, navegue para C:\Trimble 
Tutorials\TBC\Projects\Importing GNSS Data.vce e clique em Abrir. 


Se você instalou o tutorial em um local que não o padrão mostrado aqui, navegue 
para esse local. 
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O projeto abre na janela Trimble Business Center. Uma vez que nenhum dado foi 
importado para o projeto, a Visualização do plano está vazia. 


 


Observação: Esta figura mostra a Visualização de plano com um plano de fundo 
branco. Seu plano de fundo pode ser preto. Se desejar alterá-lo para branco, 
selecione Ferramentas > Opções e selecione Cor do plano de fundo: Branco na 
caixa de diálogo Opções. 


O arquivo de projeto é somente leitura. Você pode realizar as etapas do tutorial sem 
salvar o arquivo do projeto. Entretanto, se você for interrompido enquanto estiver 
realizando o tutorial, pode salvá-lo selecionando Arquivo > Salvar projeto como e 
salvando em ..\Meus documentos\Trimble Business Center, que é o local típico para 
armazenar arquivos de projeto no seu computador. Então você pode reabrir o projeto 
para continuar o tutorial mais tarde. 


Você agora está pronto para importar os dados de controle do GNSS no seu projeto. 


Etapa 2. Importar dados de controle do GNSS 


1. Selecione Arquivo > Importar .Ou clique no ícone Importar  na barra de 
ferramentas. 


O painel Importar abre no lado direito da janela Trimble Business Center. 


2. No painel Importar, clique no botão Procurar . 
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3. Na caixa de diálogo Procurar arquivo, navegue para C:\Trimble 
Tutorials\TBC\Data\Importing GNSS Data e clique em OK. 


A pasta Importing GNSS Data (Importação de dados do GNSS) contém o arquivo 
NGS Data Sheet (Planilha de dados do NGS) que será usado neste projeto. Foi 
transferido por download anteriormente do site do NGS em 
http://www.ngs.noaa.gov/cgi-bin/datasheet.prl. O acesso a este site está disponível 
usando a opção de menu Arquivo > Download de Internet. 


O conteúdo da pasta Importing GNSS Data (Importação de dados do GNSS) é 
exibido na lista Selecionar arquivo(s) no painel Importar. 


 


4. Na lista Selecionar arquivo (s), selecione B 412 ds.txt e clique no botão Importar. 


O arquivo selecionado é importado para seu projeto e o ponto computado é exibido 
na Visualização do plano. 


 



http://www.ngs.noaa.gov/cgi-bin/datasheet.prl
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5. Clique no ponto B 412 na Visualização do plano para selecioná-lo. Então clique 
com o botão direito do mouse e selecione Propriedades para exibir o painel 
Propriedades para o ponto selecionado. 


No painel Propriedades, você pode ver que os valores horizontais são definidos 
para qualidade de Controle desconhecido ; as alturas são definidas para a 
qualidade Grau de levantamento (derivado de geoide) ; a elevação é definida para 
a qualidade Controle . 


 


6. Selecione Visualizar > Explorador do Projeto. Ou clique no ícone Explorador do 
projeto  na barra de ferramentas. 


O painel Explorador do projeto é exibido. 


7. No painel Explorador do projeto, clique com o botão direito do mouse no ícone 
Pontos e selecione Expandir no menu de contexto. Então clique no ícone Arquivos 
importados e selecione Expandir. 
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Você agora pode visualizar um arquivo recém importado e o ponto resultante. 


 


Você agora está pronto para importar os dados estáticos do GNSS para seu projeto. 


Etapa 3. Importar dados estáticos do GNSS 


1. Selecione Arquivo > Importar .Ou clique no ícone Importar  na barra de 
ferramentas. 


O painel Importar abre no lado direito da janela Trimble Business Center. 


2. No painel Importar, clique no botão Procurar . 


3. Na caixa de diálogo Procurar arquivo, navegue para C:\Trimble 
Tutorials\TBC\Data\Importing GNSS Data e clique em OK. 


O arquivo de dados de GPS (formato ZIP) contido na pasta Importing GNSS Data 
(Importação de dados do GNSS) é exibido na lista Selecionar arquivo(s) no painel 
Importar. 


4. Selecione Static Data.zip na lista Selecionar arquivo(s) e clique no botão Importar. 


A caixa de diálogo Subir Dados Não Processados do Receptor é exibida. 
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Você pode selecionar qualquer uma das guias no canto inferior esquerdo da caixa 
de diálogo para verificar se as informações estão corretas e fazer as alterações 
necessárias. Por exemplo, você poderia corrigir um ID de ponto ou código de 
característica na guia Ponto; ou alterar a altura da antena ou o método de medição 
na guia Antena. 


Para instruções sobre a edição de tipos de antena, métodos de medição e valores 
de medição, pressione F1 para exibir o tópico de Ajuda online "Verificar Dados Não-
Processados GNSS". Na etapa 7 do tópico, clique no link Editando diversas 
alturas de antena. 


Para este tutorial, estas informações estão corretas e não precisam de alterações. 


5.  Na caixa de diálogo Verificação de dados não processados do receptor, clique 
em OK. 


Os dados estáticos do GNSS são importados para seu projeto e exibidos na 
Visualização do plano. 


 


Para este projeto, você precisará unir alguns pontos, como explicado no próximo 
procedimento. 


Etapa 4. Unir pontos 
Os pontos fsi 16406 a e fsi foram importados com variações de nome ligeiramente 
diferentes. Portanto, os pontos devem ser unidos. 


1. Selecione Ponto > Unir pontos. 
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O painel Unir pontos é exibido. 


 


2. Porque o fsi está localizado perto do fsi 16406 a, clique no ícone Mais zoom  na 
barra de ferramentas para ampliar a exibição na Visualização do plano para ver 
ambos os pontos. Ou posicione o cursor sobre a Visualização do plano e use a 
roda do mouse para aproximar o zoom. 


 


3. No painel Unir pontos, clique no campo Dados e selecione fsi e fsi 16406 a na 
Visualização do plano arrastando uma caixa em torno deles. 


fsi e fsi 16406 a são exibidos na lista Pontos selecionados. 


4. Na área Ponto Final, certifique-se de que o fsi está selecionado na lista suspensa 
Selecionar ponto. 


5. Na lista Pontos selecionados, certifique-se de que tanto a caixa de seleção fsi 
16406 a quanto à fsi estão marcadas. 


6. Clique no botão OK. 


7. No painel Explorador de projeto, clique no símbolo + antes do ícone Pontos para 
expandir a lista de pontos. Observe como os pontos foram unidos. 


fsi e fsi 16406 a antes de unir: 
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fsi depois de unir: 


 


Uma vez que você uniu os pontos, o indicador vermelho Computar projeto 
requerido (localizado na parte inferior da janela Trimble Business Center) acende 
para indicar que você deve computar o projeto novamente. 


 


8. Clique no indicador vermelho Computar projeto requerido ou pressione F4 para 
computador o projeto novamente. 


Agora você está pronto para fazer o download de dados para estações de referência. 


Etapa 5. Fazer download de dados da estação de 
referência 


Neste procedimento, você usará o comando Download de Internet para fazer o 
download de dados da estação de referência de um site CORS local. 


1. Selecione Arquivo > Download de Internet. Ou clique no ícone Download de 
Internet  na barra de ferramentas. 


O painel Download de Internet é exibido. 


 


2. Clique no ícone Configuração de download de Internet  localizado na parte 
superior do painel. 


3. Na caixa de diálogo Configuração de download da Internet, clique no botão Novo 
site. 
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A caixa de diálogo Novo site é exibida. Para este projeto, você selecionará a partir 
de uma lista de provedores disponível no site da Trimble. 


4. Selecione a opção Selecionar de uma lista predefinida e certifique-se de que a 
caixa de seleção abaixo esteja marcada. Então clique em OK. 


A caixa de diálogo Adicionar provedor de estação de referência predefinido é 
exibida mostrando a lista atual de dados de provedores de estação de referência do 
site da Trimble. Os provedores são listados em sequência, iniciando com aquele 
mais perto do local central do projeto. 


Observe que você pode clicar em qualquer cabeçalho de coluna para classificar as 
linhas com base na coluna. 


 


5. Na caixa de diálogo Adicionar provedor de estação de referência predefinido, 
selecione CORS, MARSHALL FIELD p041 na lista. Então clique em OK. 


As propriedades do site para essa estação de referência são exibidas na caixa de 
diálogo Propriedades do novo site para estações de referência do grupo é 
exibida. Você não precisa fazer nenhuma alteração. 


6. Clique em OK. 


O provedor selecionado é exibido na caixa de diálogo Configuração de download 
de Internet. 


 


7. Clique em OK. 
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O provedor selecionado é exibido no painel Download de Internet. 


 


8. Clique duas vezes em P041 – CORS, MARSHALL FIELD, ou selecione a estação e 
clique no botão Automático no botão na parte inferior do painel. 


A caixa de diálogo Parâmetros de download é exibida. Se o projeto incluir diversas 
medições de tempo, você pode selecioná-los na lista suspensa. Mas, uma vez que o 
projeto possui somente uma medição de tempo, você não precisa fazer uma 
seleção. 


9. Clique em OK. 


Uma nova guia nº 1 é exibida no painel Download de Internet, mostrando os 
arquivos que estão sendo transferidos por download e os arquivos prontos para 
importação. A ação associada a cada arquivo é exibida na coluna Ação. Você pode 
alterar qualquer ação selecionando-a. 


 


Observação: Os arquivos de log e texto leiame (.txt) não podem ser importados, 
mas podem ser salvos com os dados do projeto. Para fazer isso, você alteraria a 
ação de Excluir para Salvar. 


10. Clique no botão Importar na guia nº 1 para importar o intervalo de tempo. 


A caixa de diálogo Subir Dados Não Processados do Receptor é exibida. 
Normalmente, você revisaria os dados em todas as guias para garantir que estejam 
corretos. Para este tutorial, tudo está correto, por isso não há necessidade de 
realizar essa revisão. 
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11. Clique em OK. 


Os dados de estação de referência recém importados são representados no painel 
Explorador do projeto e na Visualização do plano. 


 


Agora você está pronto para fazer o download de dados de órbita precisos para seu 
projeto, de modo a poder processar linhas de base. 


Etapa 6. Download de dados de órbita precisos 
Para processar linhas de base no seu projeto, você pode fazer download e importar as 
órbitas precisas para o intervalo de tempo dos dados do GNSS. Porque os dados para 
este projeto foram coletados no passado, você pode usar os dados de órbita final ao 
processar as linhas de base.  


1. No painel Download de Internet, clique duas vezes em Órbitas finais do IGS. 
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A caixa de diálogo Parâmetros de download é exibida. 


 


Se o projeto incluir diversas medições de tempo, você pode selecioná-los na lista 
suspensa. Mas, uma vez que o projeto possui somente uma medição de tempo, 
você não precisa fazer uma seleção. 


2. Clique em OK. 


Os arquivos são exibidos para download na guia nº 2. 


 


3. Repita esse procedimento para Órbitas Glonass Finais do IGS na guia Inicial no 
painel Download de Internet. 


4. No painel Download de Internet, clique no botão Importar nas guias nº 2 e nº 3 
para importar cada intervalo de tempo. 


A seguir, você importará uma imagem que inclua dados com referência geográfica 
integrados no arquivo de imagem em si. A imagem será exibida na Visualização do 
plano com base nas coordenadas globais especificadas nos dados de referência 
geográfica. 


Observação: Você também pode importar um arquivo de imagem que não inclua dados 
com referência geográfica integrada, mas use, em vez disso, um arquivo de dados com 
referência geográfica mundial. O arquivo associado deve ter o mesmo nome de arquivo 
que a imagem com referência geográfica, mas com uma extensão de arquivo diferente 
(por exemplo, .wld ou .ini). 
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Etapa 7. Importar uma imagem com referência 
geográfica 


1. Selecione Arquivo > Importar .Ou clique no ícone Importar  na barra de 
ferramentas. 


O painel Importar abre no lado direito da janela Trimble Business Center. 


2. No painel Importar, clique no botão Procurar . 


3. Na caixa de diálogo Procurar arquivo, navegue para C:\Trimble 
Tutorials\TBC\Data\Importing GNSS Data e clique em OK. 


O conteúdo da pasta Importing GNSS Data (Importação de dados do GNSS) é 
exibido na lista Selecionar arquivo(s) no painel Importar. 


4. Na lista Selecionar arquivo(s), selecione Westmoore2.tif e clique em Importar. 


Clique em Não na caixa de diálogo Importar erros. A imagem da foto é exibida na 
Visualização do plano. 


 


Se a imagem não for exibida corretamente (por exemplo, a imagem for exibida em 
uma caixa preta), você pode precisar alterar a resolução da tela para minimizar a 
quantidade de memória necessária para exibi-la. Alterar para uma resolução de tela 
inferior reduzirá a qualidade da imagem, mas não alterará o tamanho da imagem em 
Visualização do plano. Em muitos casos, você nem sequer notará a mudança de 
qualidade. 
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Uma vez que Westmoore2.tif é uma imagem de resolução muito alta, é possível 
alterar para uma resolução menor sem perder qualidade significativa. Selecione 
Ferramentas > Opções. Na caixa de diálogo Opções, clique no botão Avançado. 
Na caixa de diálogo Opções gráficas avançadas, selecione a opção Reduzido e 
selecione 512x512. Então clique em OK e em OK. 


5. Use a roda do mouse para aproximar a imagem como mostrado aqui. 


Observe que você pode selecionar pontos e linhas de base, que agora são 
sobrepostos à imagem. 


 


Por padrão, as imagens em si não são selecionáveis na Visualização do plano. 


6. Para tornar a imagem selecionável na Visualização do plano: 


a. Selecione Visualizar > Gerenciador do filtro de visualização. 


b. No painel Gerenciador do filtro de visualização, clique no ícone 
Configurações avançadas do filtro de visualização . 
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c. Na caixa de diálogo Configurações avançadas do filtro de visualização, 
marque a caixa de seleção Selecionável para Imagens com referência 
geográfica. Então clique em OK. 


 


7. Para visualizar as propriedades para a imagem com referência geográfica, clique no 
canto superior direito da imagem em Visualizar plano para selecioná-la. Então 
clique com o botão direito do mouse e selecione Propriedades no menu de 
contexto. 


Há duas configurações no painel Propriedades que podem ser modificadas: 


 No painel de Visualizar propriedades, é possível optar por mover a imagem 
para frente ou para trás com relação às outras imagens ao inserir um valor de 1 
a 5 (1 é o nível mais à frente ou visível e 5 é o nível mais atrás ou oculto). 


Também é possível clicar com o botão direito sobre a imagem na Plan 
Visualização do plano e selecionar uma opção de menu para mover para frente 
ou para trás. 


 A configuração Visível permite-lhe exibir ou não a imagem na Visualização do 
plano. 


Você concluiu a importação de dados do GNSS para o seu projeto. 


8. Selecione Arquivo > Fechar projeto. 


A caixa de diálogo Salvar alterações é exibida. Se você salvou o projeto em um 
novo local ou com um novo nome, pode clicar em Sim. Caso contrário, clique em 
Não. 


Agora que você importou os dados do GNSS para o seu projeto, está pronto para 
processar as linhas de base do GNSS. Consulte o tutorial Processando linhas de base 
do GNSS para instruções. 
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Sobre este tutorial 
Neste tutorial, você importará dados da estação total para um projeto que já contém 
dados de nível e de GNSS. Então você excluirá uma configuração incorreta, mudará o 
tipo de prisma para uma observação e visualizará residuais de um ângulo médio. 


Observação: Se você precisar de ajuda adicional em qualquer momento em que estiver 
usando o software, pressione F1 para exibir para a ajuda online. 


Etapa 1. Abra um projeto 
Para esse tutorial, você usará o arquivo de projeto Importing Total Station Data.vce. Os 
dados do GNSS e de nível digital já foram importados para o projeto, e as linhas de base 
do GNSS foram processadas. 


1. Na barra de menu do Trimble Business Center, selecione Arquivo > Abrir 
projeto. Ou clique no ícone Abrir projeto  na barra de ferramentas. 


2. Na caixa de diálogo Abrir arquivo, navegue para C:\Trimble 
Tutorials\TBC\Projects\Importing Total Station Data.vce e clique em Abrir. 


Se você instalou o tutorial em um local que não o padrão mostrado aqui, navegue 
para esse local. 
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O projeto abre na janela Trimble Business Center. 


 


Observação: Esta figura mostra a Visualização de plano com um plano de fundo 
branco. Seu plano de fundo pode ser preto. Se desejar alterá-lo para branco, 
selecione Ferramentas > Opções e selecione Cor do plano de fundo: Branco na 
caixa de diálogo Opções. 


O arquivo de projeto é somente leitura. Você pode realizar as etapas do tutorial sem 
salvar o arquivo do projeto. Entretanto, se você for interrompido enquanto estiver 
realizando o tutorial, pode salvá-lo selecionando Arquivo > Salvar projeto como e 
salvando em ..\Meus documentos\Trimble Business Center, que é o local típico para 
armazenar arquivos de projeto no seu computador. Então você pode reabrir o projeto 
para continuar o tutorial mais tarde. 


Você agora está pronto para importar os dados da estação total para seu projeto. 


Etapa 2. Importar os dados da estação total 
Para este tutorial, você importará um arquivo de dados contendo dados transversos 
coletados com uma estação total. Entretanto, em função da exatidão do equipamento 
usado para esse levantamento, você aumentará a tolerância padrão especificada para 
ângulos médios no seu projeto antes de importar os dados. 


1. Para aumentar a tolerância padrão especificada para ângulos médios, faça o 
seguinte: 


a. Selecione Projeto > Configurações do Projeto. 
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b. Na caixa de diálogo Configurações do projeto, selecione Cálculos > Ângulos 
médios no painel de navegação. 


c. Na seção Tolerância de ângulos médios, insira 0°00'05" nos campos Ângulo 
horizontal e Ângulo vertical. 


 


Você concluiu a importação de dados. 


2. Selecione Arquivo > Importar .Ou clique no ícone Importar  na barra de 
ferramentas. 


O painel Importar é exibido no lado direito da janela Trimble Business Center. 


3. No painel Importar, clique no botão Procurar . 


4. Na caixa de diálogo Procurar pasta, navegue para C:\Trimble 
Tutorials\TBC\Data\Importing Total Station Data e clique em OK. 


A pasta Importação de dados da estação total contém o arquivo de dados JXL que 
será usado neste projeto. 


O conteúdo da pasta Importação de dados da estação total é exibido na lista 
Selecionar arquivo(s) no painel Importar. 


 


5. Na lista Selecionar arquivo (s), selecione filloop.jxl e clique no botão Importar. 


Uma vez que o software detecta uma diferença entre o sistema de coordenadas 
especificado no projeto e o sistema de coordenadas especificado no arquivo 
importado, o diálogo da mensagem Sistema de coordenadas do projeto é exibida. 


6. No diálogo da mensagem Sistema de coordenadas do projeto, clique no botão 
Detalhes. 
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O Relatório de comparação do sistema de coordenadas é exibido em uma janela do 
navegador, onde os valores do projeto e os valores importados são mostrados lado 
a lado. As diferenças são realçadas. Para este tutorial, você usará os valores do 
projeto. 


7. Feche o relatório e selecione a opção Manter a definição de projeto existente no 
diálogo da mensagem Sistema de coordenadas do projeto. Então clique em OK. 


Um diálogo de mensagem Importar erros é exibido informando que há um aviso 
associado à importação e perguntando se você deseja revisar o Sumário de 
importação.  


8. Na caixa de diálogo Erros de importação, clique em Sim. 


O Sumário de importação abre na janela do navegador. 


9. Role para o final do relatório onde o aviso é exibido. 


O aviso indica que uma configuração de estação está incompleta. Para este 
levantamento, os agrimensores no campo iniciaram por engano usando a 
Configuração da Estação Mais para o tipo de configuração, que é representado pelo 
filtro (S1). Em vez disso, eles devem ter iniciado com um tipo de configuração Leitura 
de Nivelamento Única e Giros, que é representado pelo filtro (S2). Para solucionar 
esse problema, você excluirá a primeira configuração. 


10. Para excluir a configuração, faça o seguinte: 


a. Clique no link de aviso no relatório Resumo da importação para selecionar a 
configuração da estação. 


b. Na janela Trimble Business Center, clique com o botão direito na Visualização 
do plano e selecione o Explorador de seleção.  


Observação: Se você clicar em qualquer outro lugar na janela antes de clicar com o 
botão direito na Visualização do plano, a configuração da estação não será mais 
selecionada. Além disso, se selecionar novamente o aviso no relatório, o número da 
configuração será diferente daquele mostrado abaixo. 
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O painel Explorador de seleção é exibido. A configuração que você está 
excluindo está selecionada na lista Captura Instantânea de Seleção. 


 


c. Clique com o botão direito no filtro (S1) na lista Captura Instantânea de 
Seleção e selecione Excluir. 


11. Selecione Projeto > Computar projeto, ou pressione F4 para recalcular o projeto. 


12. Clique no ícone Mais zoom  na barra de ferramentas para ampliar a exibição na 
Visualização do plano como mostrado aqui. Ou clique na Visualização do plano e 
use a roda do mouse para aproximar o zoom. Pressione a roda do mouse e mova o 
mouse para o centro dos pontos. 
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Com a visualização ampliada, é possível ver mais facilmente os dados recém 
importados. 


13. Selecione Visualizar > Explorador do Projeto. Ou clique no ícone Explorador do 
projeto  na barra de ferramentas. 


14. No painel Explorador do projeto, clique no símbolo de mais antes do ícone 
Arquivos importados. Então clique no sinal de mais antes do arquivo filloop.jxl 
recém importado para visualizar os dados importados. 


O nó Redes Transversais indica que o agrimensor concluiu um ajuste transversal 
no Controlador de levantamento. 


 


 


Etapa 3. Visualizar as propriedades para um ajuste 
transversal 


1. No painel Explorador do projeto, clique com o botão direito em Redes 
Transversais > fieldcheck (filloop.jxl) e selecione Propriedades. 
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O painel Propriedades exibe valores de exatidão e desajuste ajustado e pré-ajuste, 
junto com métodos de distribuição de erro, pontos inicial/final/intermediário e o tipo 
de ajuste. Também mostra se esse ajuste é o último feito a essas coordenadas de 
ponto. 


 


Uma vez que o ajuste pode ser feito diversas vezes com o software Trimble 
Access/Survey Controller, apenas um ajuste é usado na solução desses pontos. Há 
múltiplas transversais em um arquivo de trabalho que ajustam outros pontos. 


Os pontos que são ajustados por um ajuste transversal estão em um estado "fixo". 
Eles não serão recalculados por uma mudança às coordenadas dos pontos inicial e 
final a menos que você realize um ajuste de rede de quadrados mínimos (selecione 
Levantamento > Ajustar rede). 


Para visualizar esse estado, você dará uma olhada no Relatório de derivações de 
ponto para o ponto w. Esse ponto é de interesse porque você sabe que os 
agrimensores no campo inseriram o tipo de prisma incorreto para observações 
usadas para determinar esse ponto. 


2. Para visualizar o Relatório de derivações de ponto, faça o seguinte: 


a. Selecione o ícone Mais zoom  na barra de ferramentas ou use a roda do 
mouse para aproximar no ponto w na Visualização do plano. 


b. Clique no ponto w e selecione o Ponto w na lista. 


c. Clique com o botão direito na Visualização do plano e selecione Relatório de 
derivações de ponto na lista. 
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O relatório é exibido em uma janela do navegador. Você pode ver que os 
indicadores Usados para calc. estão na linha Ajuste transversal do relatório. 
Você também pode ver as grandes diferenças entre o ponto e o ângulo médio w-
x-w (M11). Esse é o ângulo médio para o qual o tipo de prisma foi 
incorretamente inserido no campo. Você corrigirá esse erro na próxima etapa. 


 


 


Etapa 4. Corrigir um erro de tipo de prisma feito no 
campo. 


Porque os agrimensores no campo inseriram o tipo de prisma incorreto para 
observações dentro do ângulo médio w-x-w (M11), você deve corrigir o erro antes de 
continuar. Esse erro também foi incluído no ajuste transversal feito no software de 
campo. Porque corrigir esse erro anulará os resultados do ajuste transversal, você 
seguirá em frente e limpará os resultados do ajuste transversal antes de corrigir o tipo de 
prisma. 


Observação: Embora o software não seja compatível com o desempenho de um ajuste 
transversal dentro do projeto (somente pode importar resultados de ajustes transversais 
do Survey Controller ou do Trimble Access), não é compatível com ajuste de rede de 
quadrados mínimos (consulte o tutorial Ajuste da rede). Se esse fosse um trabalho 
autônomo e você estivesse baseando o projeto nas coordenadas do ajuste transversal, 
precisaria corrigir o tipo de prisma e reajustar a transversal no software de campo. Então 
você pode importar novamente o arquivo para seu projeto: 


1. No painel Explorador do projeto, clique com o botão direito em Redes 
Transversais > fieldcheck (filloop.jxl) e selecione Limpar o resultado do ajuste 
transversal. 
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É exibido um sinalizador de erro no ponto w agora na Visualização do plano 
indicando que o ponto ultrapassa as tolerâncias especificadas para pontos no 
projeto. 


 


2. Selecione o ponto w na Visualização do plano e selecione Ponto: w na lista. Então 
clique com o botão direito e selecione Relatório de derivações de ponto. 


Os valores de ajuste transversal não são mais exibidos no relatório. O ângulo médio 
w-x-w (M11) é exibido com texto vermelho indicando que o ponto ultrapassa as 
tolerâncias que você especificou para ângulos médios anteriormente no tutorial. Com 
os resultados do ajuste transversal limpos, agora você está pronto para corrigir o tipo 
de prisma incorreto. 


3. No Explorador de projeto, expanda Arquivos importados > filloop.jxl > x (S7) > 
Giros > Set 1. Então clique com o botão direito em x-w (T161) e selecione 
Propriedades no menu de contexto. 


As propriedades para a observação são exibidas no painel Propriedades. 


 


Observe que você pode ter selecionado qualquer uma das observações dentro do 
ângulo médio w-x-w (M11), uma vez que será solicitado a alterar todas elas. 


4. No painel Propriedades, selecione Inclinável grande de 63,5mm na lista suspensa 
Tipo de prisma na seção Informação alvo. 
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5. Quando for exibida a mensagem perguntando se você deseja estender a mudança 
de prisma a todas as outras observações dentro desse ângulo médio, clique em 
Sim. 


A mudança de prisma é feita para todas as observações dentro do ângulo médio. 
Você agora deve recalcular o projeto. 


6. Selecione Projeto > Computar projeto ou pressione F4 para recalcular o projeto. 


Um sinalizador não é mais exibido para o ponto w na Visualização do plano. 


7. Abra outro Relatório de derivações de ponto para o ponto w e revise as alterações. 


Agora você está pronto para visualizar residuais para um ângulo médio no projeto. 


Etapa 5. Visualizar resíduos de ângulo médio 
Um ângulo médio representa a combinação e a média de observações redundantes para 
o mesmo ponto. Você pode visualizar os residuais para qualquer ângulo médio e, caso 
deseje, desativar quaisquer observações remotas.  


Para este tutorial, você visualizará residuais para o ângulo médio w-x-y (M12). Esse 
ângulo médio é sinalizado na Visualização do plano porque há observações dentro 
dele que excedem as tolerâncias definidas por você para ângulos médios mais cedo 
neste tutorial. 


1. No Explorador de projeto, expanda filloop.jxl > x (S7) > Giros. Então clique com o 
botão direito em w-x-y (M12) e selecione Residuais de ângulos médios no menu 
de contexto. 


A caixa de diálogo Residuais de ângulos médios é exibida. 


 


Os sinalizadores são exibidos para quatro observações dentro do ângulo médio. 
Você desativará as observações com os residuais maiores primeiro para ver se isso 
corrige as outras observações sinalizadas. 







 Etapa 5. Visualizar resíduos de ângulo médio  


Tutorial Trimble Business Center – Importando dados da estação total 13 


2. Desmarque a caixa de seleção para a observação x-y (T170). 


Observe que conforme as observações são ativadas ou desativadas, as médias e os 
residuais são recalculados para que você possa ver imediatamente os efeitos da 
alteração. Porém, essas alterações são temporárias e não serão aplicadas ao 
projeto até que você clique em OK. 


É possível clicar no botão Relatório para visualizar o Relatório de ângulos médios, 
que fornece informações adicionais sobre cada observação. 


3. No diálogo Alterar status da observação, clique em Sim para aplicar a mesma 
alteração a x-y (T172). 


Observe que os sinalizadores ainda serão exibidos para x-y (T166) e x-y (T168), 
então você precisará desativá-los também. 


4. Desmarque a caixa de seleção para a observação x-y (T168). 


5. No diálogo Alterar status da observação, clique em Sim para aplicar a mesma 
alteração a x-y (T166). 


6. Clique em OK. 


7. Selecione Projeto > Computar projeto ou pressione F4 para recalcular o projeto. 


Ângulo médio w-x-y (M12) não é mais sinalizado na Visualização do plano. 


 


Você concluiu a importação de dados da estação total para o seu projeto. 


8. Selecione Arquivo > Fechar projeto. 


A caixa de diálogo Salvar alterações é exibida. Se você salvou o projeto em um 
novo local ou com um novo nome, pode clicar em Sim. Caso contrário, clique em 
Não. 
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Sobre este tutorial 
Neste tutorial, você processará linhas de base dos dados do GNSS que já foram 
importados para o projeto. 


Observações:  


 Para este tutorial, você processará linhas de base para dados incluindo sinais tanto 
L1 quando L2. Você pode realizar os procedimentos descritos no tutorial enquanto 
executa o software Trimble Business Center com a licença do produto Survey 
Standard; entretanto, apenas os dados L1 serão processados. A licença do produto 
Survey Advanced é necessária para processar linhas de base para dados L1 e L2. 
Para verificar a licença do produto para sua instalação, selecione Help > About 
Trimble Business Center e clique no botão Licença. Os recursos licenciados são 
exibidos na lista Recursos. 


 Se você precisar de ajuda adicional em qualquer momento em que estiver usando o 
software, pressione F1 para exibir para a ajuda online. 


 


Etapa 1. Abra um projeto 
Para esse tutorial, você usará o arquivo de projeto Processing GNSS Baselines.vce. Os 
dados do GNSS já foram importados para o projeto, mas as linhas de base ainda não 
foram processadas. 


1. Na barra de menu do Trimble Business Center, selecione Arquivo > Abrir 
projeto. Ou clique no ícone Abrir projeto  na barra de ferramentas. 


2. Na caixa de diálogo Abrir arquivo, navegue para C:\Trimble 
Tutorials\TBC\Projects\Processing GNSS Baselines.vce e clique em Abrir. 


Se você instalou o tutorial em um local que não o padrão mostrado aqui, navegue 
para esse local. 
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O projeto abre na janela Trimble Business Center. 


 


Observação: Esta figura mostra a Visualização de plano com um plano de fundo 
branco. Seu plano de fundo pode ser preto. Se desejar alterá-lo para branco, 
selecione Ferramentas > Opções e selecione Cor do plano de fundo: Branco na 
caixa de diálogo Opções. 


O arquivo de projeto é somente leitura. Você pode realizar as etapas do tutorial sem 
salvar o arquivo do projeto. Entretanto, se você for interrompido enquanto estiver 
realizando o tutorial, pode salvá-lo selecionando Arquivo > Salvar projeto como e 
salvando em ..\Meus documentos\Trimble Business Center, que é o local típico para 
armazenar arquivos de projeto no seu computador. Então você pode reabrir o projeto 
para continuar o tutorial mais tarde. 


Antes de processar linhas de base para o projeto, você deve verificar as configurações 
de processamento de linha de base para garantir que sejam adequados para seu 
projeto. 
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Etapa 2. Especifique o intervalo de processamento. 
Antes de processar linhas de base para seu projeto, é possível escolher o intervalo (em 
segundos) no qual você deseja selecionar os dados de campo para processar ou 
escolher usar o intervalo especificado no arquivo de dados. Quanto mais curto o 
intervalo, mais dados são processados, resultando em um tempo de processamento 
mais longo e precisão mais alta. Se você selecionar um intervalo que seja mais curto 
que o intervalo no qual os dados foram coletados, o intervalo no qual os dados foram 
coletados será usado.  


Idealmente, você escolheria usar o intervalo especificado no arquivo de dados para 
garantir que esteja usando os intervalos mais curtos possíveis. Entretanto, para tempos 
de ocupação longos com intervalos (épocas) de 1 segundo ou menos, o tempo de 
processamento pode ser muito longo. Neste caso, você pode escolher um intervalo mais 
longo para encurtar o tempo de processamento. Para este tutorial, você selecionará um 
intervalo de processamento de 5 segundos para manter o tempo de processamento o 
menor possível.  


1. Selecione Projeto > Configurações do Projeto. Ou clique no ícone Configurações 
de projeto  na barra de ferramentas. 


2. No painel de navegação (esquerdo) na caixa de diálogo Configurações de projeto, 
selecione Processamento de linha de base > Processamento. 


3. Na lista suspensa Intervalo de processamento, selecione 5 (segundos). 


 


Observe que você pode selecionar outras opções que afetam o processamento de 
linha de base. Dicas úteis são exibidas na parte inferior da caixa de diálogo, ou você 
pode pressionar F1 a qualquer momento para ajuda online adicional. Para este 
tutorial, você não deve fazer nenhuma outra alteração. 


4. Clique em OK para fechar a caixa de diálogo Configurações do projeto. 


Agora você está pronto para processar linhas de base. 
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Etapa 3. Processar linhas de base 
1. Selecione Levantamento > Processar Linhas de base. Ou clique no ícone 


Processar linha de base  na barra de ferramentas. 


Observação: se nenhuma linha de base for selecionada nas diversas visualizações 
quando você selecionar o comando Processar linhas de base (como neste caso), 
todas as linhas de base no seu projeto são processadas. Se qualquer linha de base 
for selecionada, apenas as selecionadas serão processadas. 


A caixa de diálogo Processar linha de base é exibida mostrando o progresso do 
processo. 


 


Quando o processamento está concluído, as linhas de base processadas são 
listadas na tabela. Você pode classificar as linhas de base conforme o necessário 
clicando em qualquer um dos cabeçalhos de coluna. Por exemplo, é possível 
classificar as linhas de base para verificar que a precisão adequada foi alcançada 
clicando nos cabeçalhos de coluna Precisão Horiz. e Precisão Vert. 


Para ver mais informações sobre qualquer linha de base específica, selecione a 
linha e clique no botão Relatório para exibir o Relatório de processamento de 
linha de base no formato HTML na janela do seu navegador. 


Observação: Quando você selecionar para abrir um Relatório de processamento de 
linha de base em qualquer outro lugar no Trimble Business Center, um relatório 
abre na guia de visualização no formato RDLC (Report Definition Language Client-
side), que então pode ser salvo no formato PDF. 


2. Na caixa de diálogo Processar linhas de base, clique no botão Salvar para salvar 
as linhas de base processadas. 


O projeto é recalculado com as linhas de base recentemente criadas. 


Você pode visualizar o Relatório de derivação de ponto para qualquer ponto para 
ver as coordenadas resultantes.  
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3. Selecione o ponto fsi na Visualização do plano. Então clique com o botão direito do 
mouse e selecione Relatório de derivação do ponto no menu de contexto. 


O Relatório de derivação do ponto é exibido em uma janela do navegador. 


Se um sinalizador de erro tiver sido exibido para uma linha de base na caixa de diálogo 
Processar linhas de base, você precisará garantir que todas as informações sobre a 
linha de base estejam corretas (por exemplo, tipo de antena, altura da antena e nome do 
ponto). Em alguns casos, reprocessar a linha de base por si mesmo limpará um 
sinalizador usando um distribuidor de coordenadas diferente. Dependendo do problema 
subjacente, há diversas ações que você pode realizar, incluindo, possivelmente, editar a 
sessão associada. 


Na próxima etapa, você editará uma sessão e reprocessará uma linha de base como se 
o sinalizador de erro tivesse sido exibido na caixa de diálogo Processar linhas de base, 
embora não tenha sido. Isso ajudará a familiarizá-lo com o Editor de sessões. 


Etapa 4. Editar uma sessão e reprocessar uma linha 
de base 


O Editor de sessões permite analisar visualmente a qualidade dos dados não 
processados de satélite coletados para a sessão selecionada. Intervalos nos dados do 
satélite podem indicar erros no slips de ciclo do sinal do satélite, erros de intervalos 
inválidos ou outros problemas de perda de sinal. Para melhorar a qualidade de uma linha 
de base processada, é possível usar o Editor de sessões para desativar satélites em 
más condições, mascarar seções inválidas de dados de satélite e ajustar tempos de 
ocupação. 


Nesta etapa, você editará uma sessão associada com uma linha de base para corrigir 
intervalos no sinal do satélite. Então você reprocessará a linha de base.  


Observação: Este procedimento tem como objetivo familiarizar você com o Editor de 
sessões. Se esse fosse um projeto real, não haveria a necessidade de reprocessar a 
linha de base especificada, uma vez que está dentro dos critérios de aceitação 
especificados para o projeto. 
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1. Clique na Visualização do plano e use a roda do mouse para aproximar o zoom de 
modo que possa distinguir a linha de base entre os pontos fsi e 3. Então clique na 
linha de base e selecione fsi da linha de base --- 3 (B15) no menu de contexto. 


 


2. Clique com o botão direito em qualquer lugar na Visualização do plano e selecione 
Editor de sessões no menu de contexto. 


A caixa de diálogo Editor de sessões é exibida. 


 
Satélites que fornecem dados para a sessão também incluem linhas azuis e/ou 
verdes na linha de tempo. Cada linha azul representa dados coletados para o 
primeiro ponto na linha de base (fsi). Cada linha verde representa dados coletados 
do segundo ponto na linha de base (3). 


Cada satélite é representado por uma letra e um número na coluna esquerda: 


 G = Satélite GPS 


 R = Satélite GLONASS 


 E = Satélite Galileo  


Observe que o sinal para o satélite G7 termina precocemente na sessão. O satélite 
provavelmente move-se para além do horizonte nesse ponto. Embora não seja 
necessariamente o caso, você desativará os dados do satélite G7 para este tutorial. 
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3. Na coluna esquerda, clique em G7. 


Toda a linha é sombreada para mostrar que os dados do satélite serão desativados 
(ou seja, os dados não serão usados para processamento) quando você clicar em 
OK. 


A seguir, você desativará parte dos dados de satélite R17 e R18 nos quais há slips 
de ciclo como indicado pelas quebras nas linhas azul e verde. 


4. Na linha R17, clique na parte da frente do primeiro slip e arraste o cursor para o final 
da linha. 


 


5. Na linha R18, clique e arraste através dos slips de ciclo na parte anterior da sessão. 


 


Neste procedimento você está desativando dados de satélites apenas para a linha 
de base selecionada. Se você desativar um satélite para todas as linhas de base, 
selecione Projeto > Configurações do projeto. Então selecione Processamento 
de linhas de base > Satélites e remova a marca de seleção do satélite que deseja 
desativar. É também onde você pode levantar ou baixar a máscara de elevação para 
tentar melhorar os resultados da linha de base. 


6. Clique em OK para fechar a caixa de diálogo Editor de sessões. 


Agora você está pronto para reprocessar a linha de base. 


7. Com Linha de base fsi --- 3 (B15) ainda selecionada, selecione Levantamento > 
Processar linhas de base. Ou clique no ícone Processar linha de base  na 
barra de ferramentas. 


A caixa de diálogo Processar linha de base é exibida e a linha de base selecionada 
é reprocessada. 


8. Quando o processamento for concluído, clique no botão Salvar. 


Você concluiu o processamento de linhas de base do GNSS. Na próxima etapa, você 
identificará e desativará linhas de base dependentes no seu projeto. 


Etapa 5. Identificar e desativar linhas de base 
dependentes 


Se você planeja usar apenas linhas de base independentes no ajuste de rede, pode usar 
a Visualização com base em tempo para identificar linhas de base dependentes e 
desativá-las. 
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Observação: Desativar uma linha de base exclui o vetor associado. Se você deseja 
reter um vetor, deve desativar ele, e não a linha de base. Instruções para desativar 
vetores não estão incluídas neste tutorial. 


A seguir está um diagrama dos dados de levantamento usados neste projeto. 


  


Os números circulados indicam a sessão na qual cada linha de base foi medida. Na 
sessão 1, os pontos fsi, 5, frey e hanna foram ocupados. O número total de linhas de 
base que podem ser observadas durante uma sessão é igual a  


 
quando n é igual ao número de receptores usados durante a sessão. 


Por exemplo, se seus receptores foram usados em uma sessão, seis linhas de base 
podem ser observadas (4 vezes 3, dividido por 2). 


O número de linhas de base independentes para uma dada sessão é igual a . 


Para este projeto, três linhas de base independentes foram medidas para cada sessão. 
Nas cinco sessões observadas, 30 linhas de base foram medidas, mas apenas 15 são 
independentes.  


Usando a estação CORS, é possível adicionar outro receptor à conta. Isso aumenta o 
total de linhas de base por sessão para 10 e o número de linhas de base independentes 
para quatro. Há 50 linhas de base no total e 20 linhas de base independentes para todas 
as sessões. 


Para desativar linhas de base dependentes, siga estas etapas: 


1. Selecione Visualização > Nova Visualização com base em tempo. Ou clique no 
ícone Nova visualização com base em tempo  na barra de ferramentas. 
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A Visualização com base em tempo é exibida. A figura a seguir identifica as 
sessões 1 e 2. (As outras sessões não são mostradas nesta figura.) 


 


Você pode usar o mouse para navegar na Visualização com base em tempo como 
segue: 


 Coloque o cursor sobre as sessões, pressione a roda do mouse e mova o 
mouse para trás e para frente para obter uma visão panorâmica horizontal. 


 Use a roda do mouse para rolar a visualização verticalmente para cima e para 
baixo. 


 Coloque o cursor sobre as sessões, pressione e segure o botão esquerdo do 
mouse e mova o mouse para cima para aproximar e para baixo para afastar. 


 Clique com o botão direito para ver outras opções de zoom. 
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2. Para garantir que você esteja trabalhando com a sessão correta, use Shift + clique 
na coluna da esquerda para selecionar todas as linhas de base na sessão 1. 


 


3. Usando Ctrl + clique, desmarque as linhas de base independentes na sessão 1. 
Estas são as linhas de base que você não deseja desativar. 


 P041 --- hanna  
Observe que uma vez que você está usando a observação de P041 para os 
pontos na parte externa da sua rede, pode desmarcar essa linha de base. 


 5 --- fsi  


 hanna --- frey  
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 5 --- frey  


 


4. Clique com o botão direito em qualquer uma das linhas de base selecionadas na 
sessão 1 e selecione Desativar linhas de base no menu de contexto. 


Uma mensagem é exibida alertando-o de que os vetores associados serão 
excluídos.  


5. Na caixa de diálogo Excluir vetores, clique em Sim. 


6. Na Visualização com base em tempo, as linhas de base desativadas são exibidas 
com uma barra cinza escuro. 
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7. Repita este procedimento para as sessões 2 a 5, garantindo que todas as linhas de 
base dependentes sejam desativadas. 


As linhas de base independentes para cada sessão são como segue. Essas linhas 
de base não devem ser selecionadas para serem desativadas. Todas as outras 
linhas de base devem ser selecionadas para serem desativadas. 


Sessão 2: 


 3 --- filtro  


 P041 --- sixtwo  


 3 --- sixtwo  


 sixtwo --- hanna  


Sessão 3: 


 hanna --- filtro 


 filtro --- 5 


 filtro --- frey  


 P041 --- frey  


Sessão 4: 


 P041 --- fsi  


 fsi --- 3  


 3 --- sixtwo  


 3 --- 5  


Sessão 5: 


 P041 --- sixtwo  


 frey --- hanna  


 frey --- 5  


 sixtwo --- hanna  


Agora que você desativou as linhas de base, deve recalcular o projeto. 


8. Selecione Projeto > Calcular Projeto. Out pressione a tecla F4. 


Observe que sinalizadores agora são exibidos nos pontos 5 e fsi na Visualização do 
plano. 


 


9. Selecione Visualizar > Painel de sinalizadores. 
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No Painel de sinalizadores, você pode ver que dois pontos ultrapassam tolerâncias 
de ponto horizontais que foram especificadas para o projeto.  


 


Para este tutorial, você alterará a tolerância para ser menos restritiva, de modo que 
os sinalizadores não sejam mais exibidos.  


10. Para alterar as tolerâncias horizontal e vertical para pontos no projeto, faça o 
seguinte: 


a. Selecione Projeto > Configurações do Projeto. Ou clique no ícone 
Configurações de projeto  na barra de ferramentas. 


b. Na caixa de diálogo Configurações de projeto, selecione Computações no 
painel de navegação localizado no lado esquerdo da caixa de diálogo. 


c. Na seção Qualidade do levantamento, altere o campo Tolerância horizontal 
(Levantamento) para 0,025 m. Altere o campo Tolerância vertical 
(Levantamento) para 0,055 m. 


d. Clique em OK. 


Os sinalizadores não são mais exibidos na Visualização do plano ou Painel de 
sinalizadores. 


11. Para visualizar apenas observações habilitadas e linhas de base (para pós-
processamento) na Visualização do plano, faça o seguinte: 


a. Selecionar Visualização do plano 


b. Selecione Visualizar > Gerenciador do filtro de visualização. 


O painel Gerenciador do filtro de visualização é exibido. 


 


c. Selecione a guia Observações na área inferior do painel e depois selecione a 
opção Apenas observações habilitadas. 


d. Selecione a guia Tipos de dados do GNSS na área inferior do painel e depois 
selecione a opção Apenas linhas de base habilitadas. 
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e. Clique na Visualização do plano e use a roda do mouse para aproximar o 
zoom. Pressione a roda do mouse e mova o mouse para centralizar os pontos 
como mostrado na segunda figura. 


Visualização do plano antes de filtrar a visualização: 


 


Visualização do plano após filtrar a visualização: 


 


Você terminou de desabilitar as linhas de base dependentes no seu projeto. 


12. Selecione Arquivo > Fechar projeto. 


A caixa de diálogo Salvar alterações é exibida. Se você salvou o projeto em um 
novo local ou com um novo nome, pode clicar em Sim. Caso contrário, clique em 
Não. 





		Sobre este tutorial

		Etapa 1. Abra um projeto

		Etapa 2. Especifique o intervalo de processamento.

		Etapa 3. Processar linhas de base

		Etapa 4. Editar uma sessão e reprocessar uma linha de base

		Etapa 5. Identificar e desativar linhas de base dependentes









